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Preface

Manual Information

Purpose This manual provides information on the features and applications for the HView SX Pro.

Audience This manual is written for engineers, technicians, and operators responsible for installation,
setup, maintenance, and/or operation of the product, and is useful to operations personnel
for purposes of daily operation and reference.

Re\{151on Table P-1 Revision History of Manual
History

Edition Date Comments

A May 2012 Preliminary release

B August 2012 Official product release

C October 2012 Minor corrections to content

D December 2012 IP3 support; coincides with release 1.1 of the
HView Designer software.

E July 2013 Coincides with release 2.0 of the HView Designer
software

Writing To enhance your understanding, the authors of this manual have adhered to the following
Conventions text conventions:

Table P-2 \Writing Conventions

Term or .

Convention Description

Bold Indicates dialog boxes, property sheets, fields, buttons, check boxes,
list boxes, combo boxes, menus, submenus, windows, lists, and
selection names

Italics Indicates email addresses, the names of books or publications, and the
first instances of new terms and specialized words that need emphasis
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Obtaining
Documents

Table P-2 \Writing Conventions

CAPS Indicates a specific key on the keyboard, such as ENTER, TAB, CTRL,
ALT, or DELETE

Code Indicates variables or command-line entries, such as a DOS entry or
something you type into a field

> Indicates the direction of navigation through a hierarchy of menus and
windows

hyperlink Indicates a jump to another location within the electronic document or
elsewhere

Internet address | Indicates a jump to a website or URL

Indicates important information that helps to avoid and troubleshoot
problems

Technical documents can be viewed or downloaded from our website. Alternatively, contact
your Customer Service representative to request a document.

Unpacking/Shipping Information

Unpacking a
Product

u A W N =

Returning a
Product

All products have been carefully inspected, tested, and calibrated before shipment to ensure
years of stable and trouble-free service.

Check the equipment for any visible damage that may have occurred during transit.
Confirm that you have received all items listed on the packing list.

Contact your dealer if any item on the packing list is missing.

Contact the carrier if any item is damaged.

Remove all packaging material from the product and its associated components before you
install the unit.

In the unlikely event that a product fails to operate properly, please contact our Customer
Service Department to obtain a Return Authorization (RA) number, then send the unit back
for servicing.

Keep at least one set of original packaging in the event that a product needs to be returned
for service. If the original package is not available, you can supply your own packaging as
long as it meets the following criteria:

m  The packaging must be able to withstand the product’s weight.

m  The product must be held rigid within the packaging.

m  There must be at least 2 in. (5 cm) of space between the product and the container.
m  The corners of the product must be protected.

If the product is still within the warranty period, we will return it to you by prepaid ground
shipment after servicing.
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Standards

Product
Standards

There are three sets of standards used in the development of the HView SX Pro product line:
product standards, compliance standards, and safety standards.

The following product standards apply to the HView SX Pro output module. Please
reference the pertinent standard for more information.

Professional Video

SMPTE 259M
SMPTE Standard for Television - 10-Bit 4:2:2 Component and 4fsc Composite Digital Signals
- Serial Digital Interface

SMPTE 292M
SMPTE Standard for Television - Bit-Serial Digital Interface for High Definition Television
Systems

SMPTE 344M
SMPTE Standard for Television - 540 Mb/s Serial Digital Interface

DVB-ASI
Digital Video Broadcasting Interfaces for CATV/SMATV Headends and Similar Professional
Equipment

SMPTE-170M
For Analog Video Signal quality

FCC 73.699
U.S. Federal guidelines for NTSC analog composite video

ITU-R.BT 470
Guidelines for PAL analog composite video

ITU-R BT601-4
For Serial Digital Video

SMPTE 296 M
SMPTE Standard for Television - 1280x720 Progress Image Sample Structure - Analog and
Digital Representation and Analog Interface

SMPTE 274M
SMPTE Standard for Television - 1920x1080 Image Sample Structure, Digital Representation
and Digital Timing Reference Sequences for Multiple Picture Rates.

SMPTE 424M
SMPTE Standard for Television - 3 Gb/s Signal/Data Serial Interface

DVI 1.0
Digital Visual Interface 1.0, Digital Display Working Group (DDWG) (www.ddwg.org).

SMPTE 12M
SMPTE Standard for Television - Audio and Film - Time and Control Code

Xi
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Compliance
Standards

Digital Audio

AES3-2003
AES Recommended Practice for Digital Audio Engineering - Serial Transmission Format for
Two-Channel Linearly Represented Digital Audio Data

AES3id-2001
AES Information Document for Digital Audio Engineering -Transmission of AES3 Formatted
Data by Unbalanced Coaxial Cable

SMPTE 276M-1995
SMPTE Standard for Television - Transmission of AES-EBU Digital Audio Signals Over Coaxial
Cable

PT-PS Power Supply

Safety
TUV approved to latest revision of UL 60950-1 and CSA 22.2 complete with CB Report with
all country deviations'

CE Mark
EMC Compliance tested under EN 55103-1, 2 as a Class A Device in an E4 environment

NEBS
Level 3 Certification, Type 4 Environment, SBC Special Requirements, AT&T NEDS

Other Interfaces

IEEE 802.1 (Ethernet)
CSMA/CD Access Method

RS-232 (TIA-232-F)
Interface Between Data Terminal Equipment and Data Circuit-Terminating Equipment
Employing Serial Binary Data Interchange

EMC Compliance Standards
The following EMC compliance standards apply:

=  EN50081-1
= EN 55022
= EN 50082-1

= |[EC 1000-4-2 1995-01

m |EC801-31984

= |[EC 1000-4-4 1995-01

m  Part 15 of the FCC Rules

m  ICES-003 of the Canadian Department of Communications

1. A total of 8 PT-PS power supplies can be used in the Platinum frame. TUV will test for frame
leakage currents using all 8 power supplies operating simultaneously to determine the total frame
leakage current. This total frame leakage current value must meet EN60950 and CSA 22.2.
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Restriction on Hazardous Substances (RoHS) Compliance

Directive 2002/95/EC—commonly known as the European Union (EU) Restriction on
Hazardous Substances (RoHS)—sets limits on the use of certain substances found in
electrical and electronic equipment. The intent of this legislation is to reduce the amount of
hazardous chemicals that may leach out of landfill sites or otherwise contaminate the
environment during end-of-life recycling. The Directive, which took effect on July 1, 2006,
refers to the following hazardous substances:

m Lead (Pb)

= Mercury (Hg)

s Cadmium (Cd)

m  Hexavalent Chromium (Cr-V1)

m  Polybrominated Biphenyls (PBB)

m  Polybrominated Diphenyl Ethers (PBDE)

In accordance with this EU Directive, all products sold in the European Union will be fully
RoHS-compliant and “lead-free.” (See our website for more information.) Spare parts
supplied for the repair and upgrade of equipment sold before July 1, 2006 are exempt from
the legislation. Equipment that complies with the EU directive will be marked with a
RoHS-compliant emblem, as shown in Figure P-1.

RoHS
Compliant

Figure P-1 RoHS Compliance Emblem

Waste from Electrical and Electronic Equipment (WEEE)
Compliance

The European Union (EU) Directive 2002/96/EC on Waste from Electrical and Electronic
Equipment (WEEE) deals with the collection, treatment, recovery, and recycling of electrical
and electronic waste products. The objective of the WEEE Directive is to assign the
responsibility for the disposal of associated hazardous waste to either the producers or users
of these products. Effective August 13, 2005, producers or users will be required to recycle
electrical and electronic equipment at end of its useful life, and may not dispose of the
equipment in landfills or by using other unapproved methods. (Some EU member states
may have different deadlines.)

In accordance with this EU Directive, companies selling electric or electronic devices in the
EU will affix labels indicating that such products must be properly recycled. (See our website
for more information.) Contact your local sales representative for information on returning
these products for recycling. Equipment that complies with the EU directive will be marked
with a WEEE-compliant emblem, as shown in Figure P-2.

Xiii
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Figure P-2 WEEE Compliance Emblem

Safety The following safety standards apply:

Standards
s |[EC-950
m UL 60950-1
m EN60950: 1992 + A1: 1993 + A2: 1993 +A3: 1995 A4: 1997 +A11: 1997 EMKO-TSE
(74-SEC) 207/94

s UL1419
m CSAC22.2 No. 1

Safety Carefully review all safety precautions to avoid injury and prevent damage to this product or

any products connected to it. Any user-serviceable components (such as fuses or batteries)
are only replaceable by those components listed in the manual.

IMPORTANT! Only qualified personnel should perform service procedures.

Safety Terms and Symbols in this Manual

2 WARNING
Statements identifying conditions or practices that may result in
personal injury or loss of life. High voltage is present.

: CAUTION
Statements identifying conditions or practices that can result in
damage to the equipment or other property.
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Introduction

Overview

Il

The HView SX Pro multiviewer is designed for baseband applications. Integration with the
router platform provides a single system solution to enable a more efficient use of space in
today’s complex broadcast and A/V monitoring environments.

The HView SX Pro hardware is installed in the output section of a Platinum or IP3 router
frame. It takes inputs from the router where it is installed and combines those inputs on
three or six different output displays. The size of the various options determines the number
of outputs (three or six) and the number of inputs (8 to 64, with optional redundancy when
installed in a 5RU, 9RU, or15RU frame).

Note: HView SX Pro cannot be used in redundant mode in a Platinum 28RU frame, which
does not have redundant crosspoints.

All versions of the product have SDI output; depending on the option purchased, you also
have fiber optic or HDMI outputs. HDMI versions can also output DVI, though the use of a
HDMI to DVI adaptor. The HView SX Pro supports 1080p, 1080i, and 1920x 1080 pixels at
50 and 59.94 Hz per output.

In addition to the multiviewer’s outputs, connectors are optionally provided for Ethernet
connections, LTC timecode in, and AES out for audio monitoring.

With the HView SX Pro fully-integrated into your routing network, it can display any of the
Platinum or IP3 router input sources. These can be selected from a wide variety of input
modules: auto-detecting 1080p (3G only when installed in a Platinum frame)/HD/SD video
with embedded audio, analog video, and graphics input as well as discrete analog or AES
audio.

Use HView SX Pro’s HView Designer software to configure and control all audio and video
signal characteristics through integrated alarms and audio metering. With HView Designer,
you can create windows in the window editor, select preset layouts, and create custom
layouts. For more information about HView Designer features, see HView Designer on
page 4.

When connected to a CCS network, your HView SX Pro can be controlled by CCS control
applications such as CCS Navigator or Magellan control panel.

Figure 1-1 illustrates a typical control and monitoring scenario.
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Output displays Routers with
Hiiew 5% Pro modules

Configuration and contrl
with HV iew Dhessegner

Output displays

Remote control and
rrgnitoning with CC3
neteroed control devices

=

CCE Navigator

HView Dasigner

Magellan Contral Panel

Figure 1-1 HView SX Pro Configurations and Control

Main Features

Audio and Video/Graphic Inputs

m  8/16/32/64 auto sensing inputs - SD(525/625), HD up to 3G SMPTE424M/425M Level A

(3G only when installed in a Platinum frame)
m  Full screen display for any single input

m Image zooming across multiple displays (subject to multiple scaler resources being used)

m  Support for the following input video standards:
o HD 1080i 50/59.94 Hz to SMPTE 292M

o HD 1080p 50/59.94 Hz to SMPTE 424M Level A
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Audio Support

Outputs

Processing

Graphics

m 16 embedded audio input channels per source monitored with bar graph displays

m  Discrete audio monitor output on HView SX Pro-32 and HView SX Pro-64, and on all
SFP-enabled versions of the product

m  Stereo PCB audio embedded on HDMI outputs

3 (HView SX Pro-16) or 6 (HView SX Pro-32 or HView SX Pro-64) HD-SDI or 3G-SDI
outputs per card/slot (3G only when installed in a Platinum frame)

m  One of the following:

o 3 (1-slot versions) or 6 (2-slot and 4-slot versions ) HD-SDI/ 3G Fiber output via twin
transmitter SFP modules (3G only when installed in a Platinum frame)

o 3 (1-slot versions) or 6 (2-slot and 4-slot versions) HDMI outputs
m  SMPTE 292M, SMPTE 424M on SDI and (optional) Fiber outputs
m  HDMI outputs with DVI compatibility mode through use of external cable adaptor
m  Support for the following output standards:

o HD-SDI to 3G 1080p 50/59.94/60Hz Level A (3G only when installed in a Platinum
frame)

o HDMI output resolutions up to 1920 x 1080 @ 50Hz and 59.94Hz
o DVl output mode to resolutions of 1920 x 1080 @ 50Hz and 59.94Hz

Note: Three or six outputs are defined for each module. These outputs are duplicated on
the two types of output available on that module, whether those outputs are SDI, HDMI or
fiber. For example, for the HDMI output option, there are three unique outputs with three
HD-SDI duplicates. Note that on 1920x1200, the HD-SDI output is disabled.

m  Adaptive de-interlacing on each interlaced video source prior to image resizing
m  Frame delay through system of less than one frame for interlaced sources
= Multi tap %2 band interpolator to convert video read from DDR memory to 4:4:4

m  Very high quality video scaler to ensure maximum detail is rendered with minimal
re-sampling alias artifacts

m  24-bit RGB graphics plus 8 bit alpha channel for transparency and anti aliasing on video

m  Hardware mouse pointer with 2 bits of alpha and 2 bits of colour with 24 bit palette
registers

m  Graphics animation for analog clock
m  Hardware Graphics Accelerator and video compositor with alpha channel

Graphical Adornments

m  Two tally lamps per source
=  Two dynamic UMDs per source

m In-picture status display of source including video standard, CC Present, VCHIP, audio
and VBI information

m  On-screen alarms
m  CC rendering of 608 and 708 closed captions
m  Rendering OP 47 and WST subtitles
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Audio bar rendering up to 16 amplitude bars per source with graticules
Multiple analog and digital clocks and up and down timers

Multiple text boxes with assignable text source and titles

Logos and bit map insertion

Mouse cursor

On screen mouse control and menus

Alarms and Control

On-screen alarms and SNMP notification for common fault conditions, including Loss of
Sync, Frozen Video, Black picture, Closed Caption loss, and VCHIP ratings loss

Control via CCS (Navigator or Magellan) and SNMP

Complete control over local external 10/100 Ethernet interface including but not
limited to tally protocols, audio ballistics from external audio processor, layout data,
layout control, and system configuration

Limited control to Platinum resource card including XY router control and router status
UMD/Tally on Platinum through use of the LRC protocol and router database

3rd party UMD Tally controller and TSL, Image Video, Z-protocol, and Thomson
protocols with scaleability to additional protocols with future software updates

Control protocols include:

o CCS-P (Resource card or Local Ethernet)

SNMP (Resource card or Local Ethernet)

FTP (Local Ethernet)

HView Designer Editor Protocol (Local Ethernet)

HTTP web server to load HVIEW Designer Silverlight application
Automation

| I S W ]

HView HView Designer is the primary configuration and control application for HView SX Pro. It
Designer provides layout creation and design capabilities. HView Designer features include, but are
not limited to:

Standard and customized layout templates and windows

On-screen clocks and counters that can be locked to an external timecode reference
source

Standard and custom UMD/Tally indicators, borders, and labels
Audio meters and video signal monitoring

For more information, see Getting Started With HView Designer on page 34.

CCS Control with Navigator and Magellan

Using CCS Navigator control and monitoring software and Magellan control panel you can:

Select layouts that are stored on the multiviewer hardware for display
Monitor multiviewers for system diagnostic and audio and video signal alarms

For more information, see Remote Control using Navigator and SNMP on page 129.
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Optional Components

m  Serial interface support for tally systems is available through the use of a JLCooper
eBOX.

m  Should an application require interface to a serial source of UMD traffic and/or use an
unsupported protocol, a third-party device such as the TSL TallyMan or ImageVideo
TS-1000 can provide the transport and/or protocol translation required.

Applications

HView SX Pro systems can be used for, but are not limited to, the monitoring and control of
the following broadcast facility environments.

m Live production control rooms

m  Mobile production vehicles

m  Network master control operations
m  Satellite uplink stations

m  Fixed sporting installations

Non-broadcast applications of HView SX Pro include

m  Government installations
m  Data monitoring facilities

m  Security monitoring and surveillance for highways, public transportation systems,
casinos, sports stadiums, etc.

Output Module

A\

Only qualified service technicians should attempt to service HView SX Pro.

The HView SX Pro output module performs all of the system video input and output
processing. Output modules can be installed singly or in two- or four-board sets in the
output section of any Platinum or IP3 routing frame. The single slot version can take up to
16 baseband 3.0 Gbps video signals (8 in redundant or wideband mode or in a 28 RU
frame) from the frame’s crosspoint matrix module. The two-slot versions receive up to 32
baseband 3.0 Gbps video signals (16 in redundant mode or in a 28 RU frame), and four-slot
versions receive up to 64 baseband 3.0 Gbps video signals (32 in redundant mode or in a 28
RU frame).

The multiviewer's back module, which is connected to the back of the routing frame,
provides all of the connectors for output video signals, communication devices, and external
devices. A single slot version can output three SDI video and three HDMI or fiber SDI output
signals that drive the multiviewer output displays. Two- and four-slot versions can output six
SDI video and six HDMI or fiber SDI output signals that drive the multiviewer output
displays.

For information about the back module connectors, see Back Module Connectors on
page 8.
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Front Module

Wl

i —Guide peg

A/Interconnect
area
2
Fan Fan
: — USB connector
/ v\ not currently
Ejector used)
handle Monitoring LEDs

Figure 1-2 HView SX Pro Output Module Top View

Note: Two- and Four-slot HView SX Pro modules are connected together prior to installation
in the routing frame. Modules should not be separated due to heat issues.

The multiviewer's main components are:

m  Ejector handle—The output module front has the ejector/locking mechanism and
provides access to the multiviewer’s serviceable components (see Figure 1-3 on

page 7).
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m Interconnect area—Provides connectivity between HView SX Pro-32 and HView SX
Pro-64 modules.

m  USB Connector—Not currently used

m  Monitoring LEDs—Monitoring LEDs are located on the front of the output module.
Table 1-1 on page 7 describes the meaning of each LED.

m  Guide Peg—Provides stability when inserting the output module into the frame.

The module’s front provides access to LEDs and alarm indicators.

Figure 1-3 LEDs on HView SX Pro

Table 1-1 LED Status Indicators

LED Description

ACT CTRL Control system acknowledgment.
= Red (steady) — Module is being initialized.

= Green (steady) — The FPGA has configured and the control system is
communicating with the module.

= Green (flashing) — There is an alarm condition on this module.

ACT Crosspoints are routed to the module

24V Indicates the +24 V power rails are operational.
5VL Indicates the 5 VL power rail is operational.

IN 1 Indicates signal presence on the specified input.

IN 16
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Back Module  The output module back connectors provide all of the connectors for network
Connectors communication, LTC input, AES audio, and output video signals.

Interconnect
area

AES out
LTCin
Guide peg —
resting space Ethernet
SFPs

Figure 1-4 HV-SPX-16x3-0 Back Module

m Interconnect area—Provides connectivity between HView SX Pro-64 modules.

m  Guide peg resting space—\When the front module is inserted into the frame (after
the back module has been installed), the guide peg rests on the back module to align it
correctly.

HView SX Pro16

——— HOMI T ooy MY SDI2 Sus |

o == Il 000 -

Figure 1-5 HV-SXP-16x3 or HV-SXP-8x3-FR28 Back Module

TE MBS sDin SDIZ SDN3 |

06 006

Figure 1-6 HV-SXP-16x3-0 or HV-SXP-8x3-0-FR28 Back Module
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Figure 1-7 HV-SXP-32x6 or HV-SXP-16x6-FR28 Back Module
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Figure 1-8 HV-SXP-32x6-0 or HV-SXP-16x6-0-FR28 Back Module
HView SX Pro64

HIDMIDUT —eeeey S0 S0i2 SDN3
Sor=e=r= ll 000 -

LT AES 4 5

o= =1 = 00 © 00

| H S0 ouT

—0
|

M

=0
|

Figure 1-9 HV-SXP-64x6 or HV-SXP-32x6-FR28 Back Module
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Figure 1-10 HV-SXP-64x6-0 or HV-SXP-32x6-O-FR28 Back Module

SDI outputs—These SDI/HDISDI/3G SDI outputs are capable of driving 3G/HD/SD-SDI
display devices. (3G only when installed in a Platinum frame.) The SDI outputs duplicate
the contents of the other outputs on the same back module -- either HDMI or fiber SDI
outputs. For information about connecting SDI outputs, see Making SDI Device
Connections on page 20.

HDMI outputs—The HDMI outputs are capable of displaying a number of video
standards and resolutions. The signals are primary RGB. The HDMI outputs duplicate
the contents of the SDI outputs. For information about connecting HDMI outputs, see
Making HDMI Device Connections on page 20.

AES3 audio output—An AES discrete audio output facilitates connection with
external audio monitoring devices. See Connecting Output Audio Monitoring
Devices on page 24.

LTC IN—This connector is used for clock timing.

SFP modules—The Fiber SDI outputs are capable of displaying a number of video
standards and resolutions. They duplicate the contents of the SDI outputs. For
information about connecting fiber SDI outputs, see Making SFP Device
Connections on page 20 and Close the Platinum frame front panel. on page 152.

10/100/1000 Ethernet—An Ethernet port provides connectivity with HView Designer
and CCS control systems, such as CCS Navigator and Magellan control panel. In
addition, the Gbps Ethernet connections can be used to connect the multiviewer to the
following:

o External GPI hardware interface

o Mouse (for pointer functions on graphics features)

o Keyboard (to update text on titles, etc.)

For more information, see Network Connections on page 20.
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Figure 1-11 Ethernet Port LEDs
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Table 1-2 Ethernet Ports LED Status Indicators

LED Color Indication Description

ENET 1 Network Solid, green A valid connection is present on Ethernet
Link LED port 1.

ENET 1 Network Flashing, yellow There is network activity on Ethernet
Activity LED port 1.

1M
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Signal Flow
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Figure 1-12 16-Input HView SX Pro
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Overview

L\
A\

il

HView SX Pro modules are installed in the output section of Platinum or IP3 router frames.
Each module occupying one, two, or four contiguous slots. Video inputs are routed from the
router’s crosspoint modules to the inputs of the output module. The slots you select to install
the multiviewer may affect how efficiently you can populate other output slots in the router.
HView SX Pro modules are hot-swappable.

This manual assumes you are familiar with your Platinum or IP3 frame. See your router’s
manual for more information.

Potentially lethal voltages are present within the router frame during normal
operation. Disconnect all power cords from the frame before you remove the top
panel. Do not apply power to the frame while the top is open unless the unit is
being serviced by properly trained personnel.

For best results, test your system before its final installation. Verify its
configuration, cabling, and proper system operation. Observe proper anti-static and
grounding procedures while handling loose boards and servicing equipment.

Your sales representative can tell you whether you have sufficient power supplies installed in
the frame to power the installed modules.

Modules and

Options
A complete HView SX Pro product package includes both hardware and software
components, as described in the following tables.

Table 2-1 Available HView SX Pro Part Numbers and Components

Part Number

Function and Uses

HV-SXP-16x3

Single-slot HView SX Pro with 16 input channels, three HDMI outputs, and three SDI
outputs

HV-SXP-16x3-0O

Single-slot HView SX Pro with 16 input channels, three SDI outputs, and three (fiber)
optical SDI outputs

HV-SXP-8x3-FR28

Single-slot HView SX Pro with 8 input channels, three HDMI outputs, and three SDI
outputs, for use in 28RU Platinum frames only

HV-SXP-8x3-0O-FR28

Single-slot HView SX Pro with 8 input channels, three SDI outputs, and three (fiber)
optical SDI outputs, for use in 28RU Platinum frames only

15
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Table 2-1 Available HView SX Pro Part Numbers and Components (Continued)

Part Number

Function and Uses

HV-SXP-32x6

Two-slot HView SX Pro with 32 input channels and HDMI outputs and six SDI outputs

HV-SXP-32x6 -O

Two-slot HView SX Pro with 32 input channels, six SDI outputs, and six optical SDI
outputs

HV-SXP-16x6-FR28

Two-slot HView SX Pro with 16 input channels and HDMI outputs and six SDI outputs,
for use in 28RU Platinum frames only

HV-SXP-16x6-0O-FR28

Two-slot HView SX Pro with16 input channels, six SDI outputs, and six optical SDI
outputs, for use in 28RU Platinum frames only

HV-SXP-64x6

Four-slot HView SX Pro with 64 input channels, six HDMI outputs, and six SDI outputs

HV-SXP-64x6-0

Four-slot HView SX Pro with 32 input channels, six SDI outputs, and six (fiber) optical

SDI outputs

HV-SXP-32x6-FR28 Four-slot HView SX Pro with 32 input channels, six HDMI outputs, and six SDI outputs ,

for use in 28RU Platinum frames only

HV-SXP-32x6-0O-FR28 | Four-slot HView SX Pro with 64 input channels, six SDI outputs, and six (fiber) optical

SDI outputs , for use in 28RU Platinum frames only

HV-GPIO-24E GPIO over IP option

OP+SFP+TT+13+13 Small Form Factor (SFP) | 1310nm and 1310nm wavelength

OP+SFP4TT4274+29 | dualtransmitterwith 1550 4 1290nm CWDM wavelength
pathological support for

OP+SFP+TT+31+33 baseband video for 1310nm and 1330nm CWDM wavelength

OP+SFP+TT435437 | Harris Broadaast Fiber %y 500 o144 3700m cWDM wavelength
Optic Products.

OP+SFP+TT+43+45 1430nm and 1450nm CWDM wavelength

OP+SFP+TT+47+49 1470nm and 1490nm CWDM wavelength

OP+SFP+TT+51+53 1510nm and 1530nm CWDM wavelength

OP+SFP+TT+55+57 1550nm and 1570nm CWDM wavelength

OP+SFP+TT+59+61 1590nm and 1610nm CWDM wavelength

175-102010-00 Software/documentation DVD

Table 2-2 Optional Hardware Components

Part Number Function and Uses

131-100006Q00 Replacement fan
See Replacing a Fan on page 151 for instructions on

replacing a fan.

Check the release notes for your devices to determine compatibility between diffferent
hardware and software versions, in particular the HView SX Pro module and PT-RES
(Platinum frame) or PX-RES (IP3 frame) module versions.
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Installing HView SX Pro Modules

The following sections describe how to install back modules and output modules in a
Platinum or IP3 router frame. Output modules can be installed without powering down
your router frame.

Figure 2-1 illustrates two output modules installed in a 5RU Platinum router frame.

Output modules Crosspoint Input
(i.e., HV-S5XP-18) module(s) modules

_
-
-
—
-
—
-
-
—
-
-
—
—_
-—
—
-
—_
-_
=
-
—_
-
-
—

> L

Resource TDM/ Power supply
module(s) sync module(s) module(s)

Figure 2-1 Platinum 5RU Router Frame with Output Modules (front view)

Each HView SX Pro can be one slot, two slots, or four slots tall. A module that is two or four
slots tall requires two or four adjacent slots in your frame. Each HView SX Pro 64 requires 4
adjacent slots. If you are installing multiple HView SX Pro devices, they do not need to be
installed adjacent to each other.

Remove any currently installed output back modules or blank covers from the appropriate
slots on the rear of the frame (a #1 Phillips-head screwdriver is required).

Carefully align and then attach the back modules over the empty slots using the captive
SCrews.

Do not tighten down the screws completely when installing the back module. First, install
the output module, and then tighten the back module screws.

Before you install output modules, ensure you properly align each module with the
appropriate guide notches in the router frame. Failure to do so may damage the
pin connections between the back and output modules.

Open the I/0O Guide door.

The door must be fully open for modules to slide in and out correctly. An IP3 1/0O door
latches into the fan module when it is fully open.

If you have not done so already, remove any currently installed output modules from the
appropriate slots where you want to install the HView SX Pro output module.

Align the left and right sides of the individual boards that make up the HView SX Pro output
module with the guide notches of the appropriate slots in the frame (see Figure 2-2).

17
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N o il d ;
Figure 2-3 Aligning Module with Guide Door Guide Notches

6 Pull and hold the module’s extractor handle, and then slide the module assembly into the
frame until it is fully seated.

7 Let go of the extractor handle and push it into the locking position.
8 Close the I/O Guide door.
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Making System Connections

The following sections provide information about making output module connections,
including the following:

m  Making Network Connections on page 19

m  Connecting LTC In on page 19

m  Making SDI Device Connections on page 20

m  Making SFP Device Connections on page 20

m  Making HDMI Device Connections on page 20

m  Making DVI Display Device Connections on page 20

m  Connecting Output Audio Monitoring Devices on page 20

Securing Your Device Cabling

N

When making connections from external devices to the multiviewer, it is important
to properly secure the cables to your equipment rack. Use cable ties to secure the
various device cables to your equipment rack so that the rack supports the weight
of the cables. Failure to do so will cause excessive weight on the back module and
breakout module connections and connector pins, which may permanently
damage your system.

Making Network Connections

="

Each HView SX Pro has an Ethernet connection that allows you to connect directly to a local
or networked PC, so you can configure and monitor the multiviewer using HView Designer.
When the multiviewer is connected to a CCS network, you can use CCS control options
such as CCS Navigator and Magellan.

All control and monitoring communication with the multiviewer occurs through HView SX
Pro’s Ethernet port. With the exception of adding the multiviewer to a router system
database, no control of the multiviewer is possible from the Platinum frame Ethernet
connections. You cannot add a multiviewer to a router system database from Platinum, but
you can add it through a PC connected via Ethernet to a Platinum router.

LRC needs to be enabled on the PT-RES before HView SX Pro can communicate with it. See
Enabling LRC Protocol on page 31 for more information.

Connecting LTC In

Il

All SFP-enabled versions of the product, and HView SX Pro-32 and HView SX Pro-64 have
LTC input capability.

The LTC input connector takes in SMPTE-12M linear time code. For best results, connect the
SMPTE-12 M differential LTC signal to the single-ended HDBNC by connecitng the + side of
the LTC to the center pin of the HDBNC, and the shield to the shield of the HDBNC, leaving
the - side of the LTC unconnected. The input circuit is designed to work across the legal
range of levels specified in the SMPTE-12M when connected in this way.

You can also use System time or use Network Time Protocol (NTP) on the Ethernet interface
within HView SX Pro.

19
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— Supported output resolutions are subject to the capabilities of the connected display.
§ Support cannot be guaranteed for displays with non-standard timing.

Making SDI Device Connections

The Multiviewer’s back module provides three or six 3G/HD/SD-SDI output connections. (3G
is only available when installed in a Platinum frame)

All monitors need to be configured to the same resolution and frame rate, and all outputs
are synchronized with each other.

Making SFP Device Connections
HView SX Pro product packages can be identified as having SFP capability if their product

name ends in -O. For example, HView SX Pro 16-O. For SFPs that are approved for use with
HView SX Pro, see Table 2-1 on page 15.

Making HDMI Device Connections

HView SX Pro-16, HView SX Pro-32 and HView SX Pro-64 product packages have HDMI
output capability. The maximum cable length is 3 meters.

All monitors need to be configured to the same resolution and frame rate, and all outputs
are synchronized with each other.

Making DVI Display Device Connections

If your module has HDMI connectors, you can connect to a DVI display using an external
adapter. When an HDMI output is sent to a DVI monitor, embedded audio is not supported.

Depending on your output display device and the type of DVI output you are using, use the
following DVI cabling guides:

m Standard DVI-l digital/analog cable - Use this cable when outputting to a PC digital
(DVI) and analog (VGA) video monitor. This cable has a 29-pin DVI/VGA combined
receptacle connector.

= Standard DVI-D digital-only cable - Use this cable when outputting digital (DVI)
video signals only. This cable has a 19-pin DVI-D digital-only receptacle connector (no
key slot on left side of connector)

Connecting Output Audio Monitoring Devices

HView SX Pro-32, HView SX Pro-64, and all SFP-enabled versions of the product have AES
audio monitoring capability. Audio output is also available via HDMI.

Use the back module’s AES audio monitoring output to connect a compliant audio
monitoring device, for driving speakers or headphones. This allows audible monitoring of
audio sources for any program signal currently being monitored by the multiviewer.
Channels to monitor can be chosen from a single stereo pair, or any two mono channels
associated with the specific program signal.
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For audible monitoring, the program signals must be routed to one of the displays
associated with the multiviewer. You can use CCS Navigator, HView Designer, or a Magellan
Control Panel to route these signals. See Remote Control using Navigator and SNIVIP on
page 129 for more information.
= The audio source that will be output must be synchronized with the sync source. Otherwise
§ you will hear audio pops.

Connecting JLCooper eBOX Devices

HView SX Pro systems are designed to work with JLCooper eBOX Quad Serial to Ethernet
Interface. You can control up to 24 GPI input and 24 GPI output devices per eBOX. The
multiviewer communicates with eBOXes when both the multiviewer and JLCooper eBOXes
are on the same network. See Configuring Multiviewers in a Local Area Network on
page 35 for more information.

Extra serial ports available:

m  4x 9-Pin D Sub Serial Connectors
m  2x 25 Pin D Sub GPI Connectors

The GPI In connector has 24 TTL/CMOS compatible inputs with internal pull-ups to +5 volts.
The GPI Out connector has 24 TTL/CMOS compatible outputs. On both connectors, pin 1 is
the ground reference and pins 2-25 are GPI signals 1-24. The eBOX also has an e RJ-45
Ethernet Connector for LAN, WAN or Internet Control.

The eBOX must be set as a server only. A multiviewer can be connected to up to six eBOXes.
The master/slave function allows UMD-tally data to go through the master multiviewer
without external wiring.

Configuring an eBOX

To configure an eBOX, follow these steps:

1 Set SW8 to the ON position, and then re-power to access the Configuration Web Server for
the eBOX.

2 Set SW1, SW2, and SW3 to the DOWN position, and then re-power.

3 Using an external PC (on the same sub-network), launch a Web Browser and type the IP
Address of the eBOX.

Do not use Internet Explorer 7 or Firefox web browser to change he network
settings on the eBOX. Internet Explorer 6 is the only authorized application for

getting into the built-in Web Server to change the network settings.

The eBOX's default IP address is 192.168.254.102.
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W | [T

eBox

Pramary Setup information
192 168 (254 12 Dewice IF Address)

Zhb 25 |, |2%8 |0 (Subnet Mask)

192 188 | (254 (148 (Cateway Address)
00073 (Part Number)

Figure 2-4 eBOX Web Interface

Make the necessary Network changes and setup Port # 23.
If you are configuring more than one eBOX, all eBOXes are set to the same port number.

Remove any Password, and then press the SUBMIT button.

Set SW1, SW2, SW3, and SW6 to the ON position, and set SW7 and SW8 to the OFF
position.

e

1 2 3 4 5 6

Figure 2-5 eBOX Dip Switch Settings for Operation

Re-power the unit.
Ping to confirm the new Network setting.
For information about configuring your e-BOX, see your JLCooper eBOX documentation.

For information about configuring GPIs in HView Designer, see Configuring Hardware on
page 36. On the Hardware Config tab, GPI 1 to GPI 6 under the GPI heading refer to the
eBOX devices themselves. The GPIO port is the same for all eBOXes, and is normally Port
23. The GPIO Server IP should match the assigned eBOX IP address. When you are using
more than one eBOX device, the GPI mappings for the first device (GPI 1) use the first GPI
mapping IDs, normally 1-24. The GPI mappings for GPI 2 follow sequentially, so if each
eBOX has 24 ports, GPI 2 will have ports 25-48 assigned to it, and so on. Assign GPI usage
appropriately to each port.
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Configuring HView SX Pro

The frame you install your HView SX Pro in will determine the steps required to configure it
in a routing database. See the following topics:

m Configuring HView SX Pro in an IP3 Frame on page 23
m Configuring HView SX Pro in a Platinum Frame on page 23

Configuring HView SX Pro in an IP3 Frame

=

Configuring HView SX Pro in an IP3 router frame does not require any specialized
procedures. Follow the instructions provided in your IP3 Controller User Manual, ensuring
that the HView SX Pro devices are set up with the HD Video device type.

To complete this task, you should have a working knowledge of CCS Navigator. See Volume
6 of your Navigator User Manual for detailed descriptions of its installation and features. You
must use Navigator version 5.0 or higher.

Configuring HView SX Pro in a Platinum Frame

Il

A new HView SX Pro in a Platinum router frame must be configured in a router matrix. Using
Navigator’'s routing components, you can either include it in a newly created router matrix,
or you can add HView SX Pro to an existing routing matrix. Adding HView SX Pro to the
routing matrix defines which router inputs will be used as input source audio and video.

The information below describes the different methods by which you can add HView SX Pro
to a router database. It does not go into detail about any of these methods or about other
aspects of editing a router database. For more information, refer to the Volume 6 of your
Navigator User Manual.

To complete this task, you should have a working knowledge of CCS Navigator. See Volume
6 of your Navigator User Manual for detailed descriptions of its installation and features.

Your software and firmware must meet the following requirements:

= Navigator version 4.9 or higher

23
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m  PT-RES version 4.3 or higher

Creating a Routing System

If your HView SX Pro shipped preinstalled in a Platinum frame, you should start the network
configuration process by creating a routing system. Follow these steps:

1 Ensure Navigator is in Build mode.

2 Right click on Routers in the Navigation pane, and then select Create > Routing System
from the context menu.

The New Routing System Configuration dialog box opens.

Create Routing System

Mew Routing System

M ame: |

Create Optiohs
(% Start from a blark comfiguration
(™ Use an existing Routerd apper DA file or a routing system backup file

" Use a configuration from a remobe rauter server

Caonnection: |TCF';"IF‘ ﬂ |

QK. | Cancel | Help |

Figure 3-1 Create Routing System Dialog Box

3 In the Name field, enter a name for the routing system.
This is the name that will appear in the Navigation window.

4 Under Create Options, choose Start from a blank configuration.

This selection allows you to designate a new routing system, and then populate it manually
or with a system poll.

5 Place a check beside Perform System Poll.

6 In the Connection field, choose TCP/IP, and then enter the IP address for your Platinum
PT-RES module.

7 Click OK, and then wait while Navigator searches the network.

When the search is complete, a series of folders appear in the Navigation pane under the
name you provided.
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Figure 3-2 Routers Folder in the Navigation Pane

—Database Editor

Right-click the Frame in the Routers folder, and then select Poll.
Wait while Navigator polls the device.

When the frame poll is complete, double-click the Frame in the Routers folder.
The Edit Platinum Frame dialog box appears.

Select the Detected Matrices tab, and then click Copy to Configured Matrix.
On the Configured Matrices tab, click Add.
The Add WB Matrix dialog box appears.

At this point, you can choose to add a WB matrix or a redundant matrix. See the following
topics:

m  Adding a WB (Wideband) Matrix on page 26
m  Configuring a Redundant Matrix on page 28

Adding Output Modules by Polling

The Poll option is normally used if you have added HView SX Pro modules to a Platinum
frame that is already configured and in use. The Poll option queries the control system for
any programmable devices present in the system. Polling obtains information about the
current configuration of each physical device, and compares it to the information found in
the database to determine if the database information matches the actual configuration.

Ensure Navigator is in Build mode.
Right-click the Frame in the Routers folder, and then select Poll.
Wait while Navigator polls the device.

When the frame poll is complete, double-click the Frame in the Routers folder.
The Edit Platinum Frame dialog box appears.

Select the Detected Matrices tab, and then click Copy to Configured Matrix.
On the Configured Matrices tab, click Add.
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The Add WB Matrix dialog box appears.

At this point, you can choose to add a WB matrix or a redundant matrix. See the following
topics:

m  Adding a WB (Wideband) Matrix on page 26
m  Configuring a Redundant Matrix on page 28

Creating a New Routing Matrix

HView SX Pro units installed in 5, 9, or 15 RU Platinum frames can be configured as WB
matrixes or as multiviewer matrixes. HView SX Pro units installed in a 28 RU Platinum frame
can only be configured as WB matrixes.

When installed in a 5-, 9-, or 15-RU Platinum frame and configued in a WB matrix, HView
SX Pro-16 actually has 8 discrete inputs, a HView SX Pro-32 has 16 discrete inputs, and a
HView SX Pro-64 has 32 discrete inputs. You should choose this configuration option if your
Platinum frame only has one crosspoint in the zone where the HView SX Pro is being
installed, or if the module is installed in a 28 RU Platinum frame. See Adding a WB
(Wideband) Matrix on page 26.

A Multiviewer matrix uses both crosspoint cards in the frame to double the number of
inputs to the HView SX Pro, so a HView SX Pro-16 actually has 16 discrete inputs, a HView
SX Pro-32 has 32 discrete inputs, and a HView SX Pro-64 has 64 discrete inputs. See
Configuring a Redundant Matrix on page 28.

Adding a WB (Wideband) Matrix

When a HView SX Pro multiviewer is installed in a 28 RU frame, or when it is being installed
in a zone where there is only one crosspoint, you must configure it as a Wideband matrix.
When configured as a WB matrix, the module will have half the discrete inputs it would
have if it was configured with a multiviewer matrix. However, each input has a duplicate
input available for applying to layouts. See Editing a Window on page 65.
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1 At the Add WB Matrix dialog box, choose WB from the Matrix Type drop-down list box.
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Figure 3-3 WB Matrix Dialog Box

In the Name field, enter a name that identifies this particular Platinum matrix.
Choose a matrix format from the Format drop-down list box.

In the Level box, enter a number that corresponds to the level the matrix will occupy in the
routing system.

Choose the appropriate number of inputs from the # of Physical INs drop-down list box.
If you are planning on sharing inputs with another output module in the frame, select 0.

If you make changes to the # IN Slots selection, any changes you make are reflected in the
# of Physical INs selection as well. If you do not want to change the number of physical
inputs, do not change the # IN Slots selection.

In the Input Offset box, enter a number that corresponds to the point at which input
numbering starts for the HView SX Pro in the logical database.

Choose the appropriate number of outputs from the # of Physical OUTs drop-down list
box.

If you make changes to the # OUT Slots selection, any changes you make are reflected in
the # of Physical Outputs selection as well. If you do not want to change the number of
physical inputs, do not change the # OUT Slots selection.

Each slot occupied by an HView SX Pro represents eight outputs, so if you have an HView
SX Pro-64, that represents four slots, or 32 outputs.

In the Output Offset box, enter a number that corresponds to the point at which output
numbering starts for the HView SX Pro in the logical database.

In the 1/0 Card & Slots box, click the Manual radio button.

In the Output Card Type menu, select HView SX Pro 16, HView SX Pro 32, or HView
SX Pro 64.

Select the starting slot for your input modules from the Starting IN Slot drop-down list
box.

27



28

Chapter 3
Router Configuration

12

13

Il

Check that number of HView SX Pro modules in the # OUT Slots drop-down list box
corresponds to the correct number of slots occupied in the frame (this number ought to be
1/8 of the number in the # OUT Slots field).

Click OK to return to the Configured Matrices dialog box.

If you chose to share inputs (set the # Physical Inputs to 0), you must now assign inputs to
the matrix. See Manually Assigning Inputs on page 29.

Configuring a Redundant Matrix

When a HView SX Pro is configured in a redundant matrix, this doubles the number of
discrete PiPs to each device, so a HView SX Pro-16 has 16 outputs, a HView SX Pro-32 has
32 outputs, and a HView SX Pro-64 has 64 outputs.

Redundancy is not available on HView SX Pro modules in 28 RU Platinum frames.

On the Add WB Matrix dialog box, choose Multiview from the Matrix Type drop-down
list box.

The Add HView SX Matrices dialog box (Figure 3-4) opens.

Add HView SX Matrices

Matrix Type: Mulkiview Type:
i x| HviewSeP -]

Format: # Hvfiew S Modules:
|HD-5DI x| s |
# of Physical [Ns: Starting Hiew 5 Slat:

| 256 x| sl |

-

1/0 Card & Slots

(¥ Auto " Manual
Input Card Type: Input Plugins:
| | [OFTox
Starting [M Slat:

#IM Slats:

2
oK | Cancel |

Figure 3-4 AddHView SX Matrices Dialog Box

Under Multiviewer Type, choose HView SX PRO 16, HView SX PRO 32, or HView SX
64.

Choose a matrix format from the Format drop-down list box.
Choose the appropriate number of inputs from the # of Physical INs drop-down list box.

If you set this to 0, then you can assign pre-existing input modules to the HView SX Pro.
Otherwise, input modules are added, and can be configured or deleted later.

Choose the number of discrete HView SX Pro modules from the # HView SX Modules
drop-down list box.

This is the number of HView SX devices, not the number of slots occupied.
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Select the starting slot for the first (top) HView SX Pro module from the Starting HView SX
Slot drop-down list box.

Click OK to return to the Configured Matrices dialog box.
The new matrix information appears in the description boxes.

If you chose to share inputs (set the # Physical Inputs to 0), you must now assign inputs to
the matrix. See Manually Assigning Inputs on page 29.

Manually Assigning Inputs

If you chose to share inputs between the HView SX Pro and any other output modules in
the frame, you can assign these inputs on the Configured Matrices screen.

Select the HView SX Pro matrix in the Platinum Configured Matrix list.

Exdit Platinum Frame E

Lirfipred Maliioes |Mwmm“m—: | Detected Matricss | Frmware | Control Semngs |
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WE Miztree 3 24 24 HD 501 iz i
WR Mairte 1 24 24 M50 T
[Whaiview | Hiiew S P [0 |64 |EDsDl | ol
o
&
7
L
5

Advanced... | Add.. Dibate Delete A |

O Lawnl Help

b =

Figure 3-5 HView SX Pro Matrixes

In the graphical representation of the router at the right of the dialog box, the output
modules, crosspoint modules, and input modules associated with that matrix are
highlighted (blue).

Right click input modules in the Input (right) section of the selected matrix diagram, and
select Assign to HView SX Pro.

Click Advanced.
The Matrix Partition dialog box opens.
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Matrix Partition
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Figure 3-6 Matrix Partition Dialog Box

When you click on the HView SX Pro matrix in the configuration table, both crosspoints
highlight, and all the assigned input modules.

Configure levels and offsets as required.

Configuring Multiviewers in Database Editor

To open the Router Database Editor, double-click on the item inside the routing system’s
Control Views folder.

In this dialog box, you can make the following changes:

m  Configure UMD names

On the Sources tab of the Database Editor dialog box, change the contents of the
Name column to change the UMD names of devices on the multiviewer.

m  Create Destinations Representing Actual PiPs
i. Select the Sources tab in the Database Editor.
ii. Edit the PiP destinations as required.

Information on different methods of editing your PiP destinations is included in
Volume 6 of your Navigator User Manual.

iii. Ensure that the correct destination names appear (or are assigned) to the correct
control device(s).
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2 When your changes are complete, click Save, and then close the dialog box.
3 Right-click the frame in the Routing system, and select Download.
This loads the changes to the frame.

Enabling LRC Protocol

HView SX Pro communicates with the Platinum where it is installed using LRC protocol. LRC
is not enabled by default on Platinum. To enable LRC, follow these steps:

1 With Navigator in Build mode, double-click the frame in the Routers folder to open the
Edit Platinum Frame dialog box.

2 Select the Control Settings tab, and click Protocols.
3 The Change Protocol Settings screen opens.
4 On the Protocols tab, select LRCProtocol.

Change Protocol Settings x|

I Connections I Servers I Ports I

~Enable Protocols
—®Y¥ Pass Through Setttings

m'::-::"r' PassThrough

[w] ¥ Terminal v allow imput signal presence messages
(WISHMP

{‘;}CCSP v allow output signal presence messages
[W|LRCProtocol

—anhE Cptions

I Save SHMETr ApSettings

Ok I Cancel Help

Figure 3-7 Change Protocol Settings Dialob Box, Protocols Tab

5 Select the Servers tab and then place a check beside LRCTCPSrc.
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Change Protocol Settings
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Figure 3-8 Change Protocol Settings Dialob Box, Servers Tab

6 Click OK and Yes to save.

Settings should take effect in a minute or two. Do not reboot Platinum while the flashes are
being written to.
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HView Designer Description and Features

HView Designer software has three functions: to create layouts, configure hardware, and
control the HView SX Pro system. Using HView Designer, you can configure your multiviewer
system settings, and add and configure on-screen input audio and video alarms and
on-screen digital clocks.

HView Designer communicates directly with your multiviewer system over Ethernet.

Layouts created with HView Designer can be recalled on the multiviewer hardware using
CCS Navigator, Magellan, or on-screen control. For more information, see your Magellan or
Navigator documentation, or Live Operation on page 107.

Multiviewer System Configuration and Monitoring
Use HView Designer’s system configuration, control, and monitoring features to:

Configure multiviewer hardware and calibrate output display devices
Set up layouts
Configure aspect ratio markers, V-Chip rating, ATC, closed captioning, teletext, or VITC

Configure and display input audio and video signal alarms, including audio under and
over level alarms, loss of audio, video and metadata alarms, and black and frozen video
alarms

Configure system processing rules that respond to specific hardware and alarm
conditions and events

Assign inputs to windows and audio meters within layouts
Monitor input audio and video signals with user-defined alarm conditions
Configure processing rules for specific system events and conditions

Layout Creation and Design
Use HView Designer’s layout creation and design features to

Create layouts from a blank layout or a preset layout template
Select from a variety of layout backgrounds and background colors

Add layout objects, such as layout windows (made up of video inputs, borders, tally
indicators, audio meters etc.), labels, and alarms to a layout using basic Windows skills
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Resize and position video inputs and other layout objects with pixel accuracy using
direct-entry window coordinates

Open and edit layouts/files that are stored on connected multiviewer systems

You can create custom layouts for the multiviewer, or you can edit existing layouts by
modifying individual layout settings to create custom display layouts. Once a layout is
generated, you can use HView Designer to upload (publish) it to your multiviewer, or save it
to a local or network PC drive.

Getting Started With HView Designer

HView Designer is intended for use creating and modifying layouts, doing configuration of
multiviewer hardware, and controlling multiviewers.

See the following topics:

Minimum System Requirements on page 34
Logging In To HView Designer on page 34
Exiting HView Designer on page 35

Minimum System Requirements
The PC you intend to use with HView Designer should meet the following requirements.

A PC connected to a LAN with:

o Operating System: Microsoft™ Windows® XP with Service Pack 2, Windows Vista,
or Windows 7 (32- or 64-bit)

o Intel® Pentium® Il 450MHz or faster processor (or equivalent)

a A minimum of 128MB of RAM

A standard crossover or straight-through100 Mbps 100Base-T RJ-45 Ethernet cable to
connect to a PC (the frame auto-detects the cable type)

JavaScript enabled web browser; for best results use Microsoft Internet Explorer 8.0
Silverlight version 4.0
Monitor with SXGA (1280 x 1024) or higher resolution

For best results, set the display font size to Normal (Control Panel > Display > Appearance >
Font Size).

Logging In To HView Designer

To open a browser connection to a HView SX Hybrid, follow these steps:

1

In your browser, enter the IP address of the HView SX Pro and click Enter to connect.

If the HView SX Pro is off or in a failed state (i.e., disconnected), then you will see a
“browser cannot display the page” or “browser could not connect” message.

HView Designer appears.

When you are not actively using the interface for the HView SX Pro, please log off out of
the system.
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Note: The IP address is assigned to HView SX Pro, not the controller module. When you
§ change Controller modules, you should not have to reassign the IP address.

Exiting HView Designer
To log off HView Designer, do one of the following:

m  Close your browser.
m  Navigate to a different page in your browser.

HView Designer Workspace
When you start HView Designer, the Home tab is automatically selected. The workspace
appears similar to Figure 4-1.

HVilew Designer Haeris Broadoast

i Change Adire Lives

W Cicaly Hew Werdime

W Voow el Fdd Ly

Input 23

Input 25 Input 26

Shaw Full Soreen

Figure 4-1 HView Designer Workspace

The HView Designer workspace is the area from which you open, publish, create, and
modify multiviewer display layouts. The workspace has quick-access menus and palettes to
help you create and modify layouts and windows, as well as to configure audio meters, alarms,

and metadata. You can customize the HView Designer workspace to suit the tasks you are
performing.
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Each workspace element is described below:

© 06 O

®

Tabs - As you open various portions of the interface, tabs are created so you
can return to the pages in the state you most recently used them in. Each time
you open or connect to HView Designer, you start with the Home screen (or
tab). See Using Diagnostics on page 115, Working With Libraries in
HView Designer on page 83, and Configuring Hardware on page 36.

Layouts menu - Provides quick access from the Home tab to the Layouts
section for creating and editing layouts, and selecting the active preset. See
Using Diagnostics on page 115.

Library menu - Provides tools for adding layout objects such as windows,
layout templates, background images, clock images, and timers, and adding
and editing alarm templates and window and clock styles. See Working With
Libraries in HView Designer on page 83.

System - Options here provide tools to configure your hardware and display
monitors. See Configuring Hardware on page 36.

Diagnostics - These tools help determine why your hardware is not operating
as expected.

Display Devices - This section shows information of the active displays and
the active layout on the display. See Display Profiles on page 43.

Layout canvas - Displays the current active layout on the chosen display
device. If no display device is selected, or no layout exists on that device, or
the device is not currently available, no active layout will appear. See
Layouts on page 49.

Control Panel - This panel can be hidden or expanded and displays options
for the selected element in the layout canvas. See Using the Control Panel
on page 109.

Configuring Hardware

Various parameters are available for configuring the hardware on your multiviewer. You can
also configure your hardware using CCS Navigator (see Remote Control using Navigator
and SNMP on page 129) or Magellan control panel (see your Magellan User Manual).

Areas you can configure include automation, GPIs, network settings, timecode and clock
source.

To configure your hardware from HView Designer, follow these steps:

1 On the Home tab, click Hardware Configuration.
The Hardware Config tab opens or appears.
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Figure 4-2 Hardware Config Tab of the HView Designer Interface

Within the tab, parameters are organized in groups. Open or close a group by clicking the
arrow buttons. Parameters and options appear in Table 4-1 below.

2 When you have made your changes, click Save Changes.

Table 4-1 Hardware Configuration Parameters and Descriptions

Item

Function

Options

Refresh

Reads the current Server Properties settings from the HView SX Pro hardware; can
be useful when multiple PCs are connected to a single device.

Save Changes

Applies Server Properties changes to the hardware.

Sync to PC/Sync to NTP

sync to the selected time source.

This button is not available when the System Time Source (found on the
Hardware Config tab under Timecode) is set to None. When the System Time
Source is set to PC or NTP and the changes are saved, you can click the button to

Factory Reset

Returns all properties except network settings to their original configuration,
including layouts in presets. A factory reset reboots the hardware. When layouts
return to the display, the hardware refresh is complete. If you click OK on the
Factory Reset dialog before layouts have reappeared, HView Designer disconnects
and you may see a "Failure to connect" message.

Reboot Multiviewer

Restarts the HView SX Pro device.

Search

Type text and the display updates dynamically to display only items that contain

SDI Output Standard

Selects the SDI output display
resolution

that text.
Display
Output Rate Selects the output display refresh | = 50
rate = 59
= 1080i

= 1080p
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Table 4-1 Hardware Configuration Parameters and Descriptions (Continued)

Item Function Options
HDMI Output Standard Selects the HDMI output display | ® 1080p
resolution
HDMI Signalling Type Select the type of display output | ® DVI
interface. s HDMI
GPI
GPI Mapping
Usage filter Determines which GPIs are = All m Layout Recall
displayed in the list. Select a = Assigned = Pause and Resume
usage to display all GP_Is that are a Unassigned Timer
assigned to that function. :
a Set Tally m Reset and Start Timer
m FullScreen
GPI Select a GPI from the list to 1-144
change its assignment. The
mapping is based on the number | Reset—Sets the GPI back to Unassigned.
of ports per connected GPI
device. If your first device has 24
ports, those ports are mapped to
GPIs 1-24. The second GPI device
is then mapped to GPIs 25-48,
and so on.
Reset All Sets all GPIs back to Unassigned.
Refresh Updates the GPIs list to correctly display all changes since the filter was last applied.
Usage Displays the assignment for the selected GPI. To change an assignment, click the

usage and choose an item from the menu that appears.

When a usage is set, the region of the screen below the usage button updates with
parameters for that option, as follows:

Unassigned—The GPI is not
currently used.

Set Tally—Toggles the tally state.

m Scalar ID—The video window the tally is
associated with

m Tally ID—The tally the trigger is associated

with
FullScreen—Toggles a video m Group ID—The preset the GPI is associated
window to full screen state or with

back to the normal layout

m Display ID—The layout the GPI is
associated with

m Scalar ID—The video window that will be
set to full screen when the GPl is triggered

Layout Recall—Reverts to the
previous layout.

m Group ID—The preset the GPI is associated
with

m Preset ID—The layout the GPI is associated
with
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Table 4-1 Hardware Configuration Parameters and Descriptions (Continued)

Item

Function

Options

Pause and Resume Timer—
Turns the timer on or off.

Display ID—The layout the GPl is
associated with

Timer ID—The timer the GPI is associated
with

Reset and Start Timer—Reverts
the timer to its original number
and starts timer.

Display ID—The layout the GPl is
associated with

Timer ID—The timer the GPI is associated
with

GPI Triggers

All GPIs of a specific type will behave in a specific way. The following settings
determine how the five types of GPI will behave when triggered.

In EDGE TRIGGER Mode, an action takes effect when the button goes from OFF to ON, or from ON to OFF. As
long as there is a change of state, the corresponding action will take place. For example, if FullScreen Trigger is
set to 0, then closing or opening the switch from EBox will trigger the Full Screen or UnFullScreen.

In LEVEL TRIGGER mode, the action will only take effect on when the Switch/Button stays ON. For example, if
FullScreen Trigger Mode is set to 1 (LEVEL TRIGGER), then pressing and holding the button to ON state will set
the corresponding video input to FULLSCREEN, while releasing the button to OFF state will put back the
FullScreen video input back to normal layout.

connect to the eBOX server. If you
are configuring multiple eBOXes
for use with HView SX Pro, they
are all set to the same port
number, usually Port 23.

Full Screen Trigger Assigns the GPI trigger to set the | ® Edge
display to full screen, or return = Level
the previous layout to the display

Layout Recall Trigger | Assigns the GPI trigger to recall = Edge
the previous preset, or to change | [evel
to the preset indicated by the
Preset ID

Tally Trigger Assigns the GPI trigger to turn the |® Edge
tally on or off n Level

Timer Reset Trigger Assigns a GPI trigger to reset the |= Edge
timer to its original value s Level

Timer Start Trigger Assigns the GPI trigger to start or | = Edge
stop the timer a Level

GPI (Unit 1 - 6)

Enabled Select the Enabled option when | = Disable
the GPl is in use = Enable

GPIO Port The port number to be used to (4 digits)

GPIO Server IP

The IP address of the eBOX server;
this should match the assigned
eBOX IP address (see Connecting
JLCooper eBOX Devices on
page 21).

XXX XXX XXX XXX
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Table 4-1 Hardware Configuration Parameters and Descriptions (Continued)

Item Function Options
Number of Ports Enter the number of ports used. A | 24
single eBOX can use up to 24
ports.
Password You can enter a password that eBOX
will restrict access to the eBOX. If
the field is empty, no password is
required.
Password Enabled Determines whether or not the = Disable
password is required to access = Enable
eBOX controls.
GPO
GPO Mapping The table displays the relationship |® By GPOs — Displays the GPO column first.
between GPOs and PiPs. = By PiPs — Displays the PiP Column first.
Set One-One Assigns the GPOs and PiPs so that GPO1 is assigned to PiP 1, GPO 2 is assigned to
PiP2, etc. until all PiPs are used up.
Reset Sets all items so the left column (either GPOs or PiPs is sequential and the right

column is set to O.

Network Config

IP address

This is the IP address of the HView SX Pro you are connecting to.

Subnet mask

Mask address of the HView SX Pro you are connecting to.

Gateway The portion of your network that this device can communicate with
Host name The name that this HView SX Pro | <string>
displays to users
UMD
Port The communications port <string>
through which your HView SX Pro
receives UMD data
Protocol The type of UMD information the |® TSL 3.1 = Zandar
HView SX Pro expects to receive; |a TSL 4 = ROss
all suplported protocols are listed . TSLS = Image video
as options
SNMP
RW Community The SNMP group that sends <string>
requests to this HView SX Pro

Subnet mask

The portion of your network that can communicate with this device

Trap Destination IP

The address that this device will send SNMP traps to

Traps

Determines whether this HView
SX Pro sends trap data on the
SNMP network; this can create
excessive network traffic during
configuration

m Enabled
m Disabled
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Table 4-1 Hardware Configuration Parameters and Descriptions (Continued)

Item Function Options
Time Code
NTP host The source the HView SX Pro Enter the IP address of the NTP time server.

looks to when Sync Time Source
is set to NTP time

Sync time source

The source the HView SX Pro
relies on for time code input

None—When this is selected, Sync to PC is
not available in the Actions section of the
screen. When Sync to PC mode is enabled,
the button is then enabled in the Actions
section.

m Sync to PC—The HView SX Pro module
gueries the PC for the time when you click
Save Changes, and then free-runs at the
accuracy of the local oscillator. The Sync to
NTP button updates to display Sync to PC.

= Sync to NTP—If this is selected, the Sync to
PC button at the left of the page updates to
Sync to NTP and the clock source changes.

Router

IP Address [RO]

IP of the Platinum or IP3 router
controller that contains this
HView SX Pro

Based on your network's settings; by default
this field is read-only and shows the router’s
ENET1 connection IP address.

Port

The communications port
through which your Platinum
router sends and receives data.
Normally set to the default port
number 52116 which is used by
LRC protocol.

<string>

Override / Read Only Mode

Normally the Router IP address is read-only. Some routers are configured to use
more than one IP address and ENET connection. Click Override and the field
becomes read-writeable, so you can enter a different IP address. When you click
Save Changes, the connection is changed for the HView SX Pro.

Alarms

The alarm levels are universal, meaning they apply to all instances of that particular alarm on all layouts on the

system.

To modify via a slider, click on it with the mouse and drag right or left, or click right or left of the slider to move

it in that direction.

Alarm file The XML file that the alarms are | GlobalAlarmLevel.x
stored in ml
Audio over level The level over which the audio -60-0dB
must be in order to trigger an
alarm
Audio under level The level under which the audio |-60-0 dB
must be in order to trigger an
alarm
Audio under time The amount of time the audio 0-120s(3)

must be under the specified
Audio under level before an
alarm is triggered
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Table 4-1 Hardware Configuration Parameters and Descriptions (Continued)

Item

Function

Options

Black picture level
(measured in mV)

The video level at which pixels are
deemed to be black. Black is set
to 16 (default) and white is set to
235

1-763(108)

Black picture percent

The percentage of picture
allowed above the black level
threshold in a dark picture; the
threshold back-off percentage
control is provided so that a brief
period of blackness will not
trigger a Black Picture alarm

1-100% (50)

Black picture time

The amount of time the picture
contains the amount of black as
set by the Black Picture Level
and Black Picture Percent
parameters before an alarm is
triggered

0-120s(3)

Frozen picture level

The amount the picture is frozen
by the level of the Frozen picture
level parameter before a frozen
picture alarm is triggered

1-30(Q27)

Frozen picture percent

The amount the image must be
still before a frozen picture alarm
is triggered

0-120s(3)

Sync loss time

The amount of time sync must be
lost before an alarm is triggered

0-120s(3)

Temperature level

The module’s internal
temperature above which an
alarm is triggered

1-100 (27)

Automation

Port

Determines the source of
automation commands the device
will accept

4002 (default)
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Display Profiles

Display Profile Overview

Click a display to
view the current
layout on that
display.

Active layout on
the selected
display

When the control
panel is open, you
can control the
active layout. See
Using the Control
Panel on page 109
for more
information.

The canvas area of the Home tab allows you to view an entire display profile, one layout at a
time. HView Designer uses the following terminology:

m Display: a physical monitor that shows a layout.
m Layout: the content that appears on one display.

m  Preset: A group of layouts that show on the displays. Presets assign layouts as a group
to monitors in order to maximize the scalar resources (the number of video inputs) of
the HView SX Pro hardware.

Click on the Display bar at the top of the screen to see the layout assigned to a particular
display. The layout and its currently assigned inputs show on the screen. From here, you can
click Edit Active Layout to open the layout in the layout editor. See Using Layout Editor on
page 54.

LRC Source

Input 3

=) Control Panel

Figure 5-1 Display 1 is Currently Selected
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Configuring Displays and Display Profiles

Before you can configure your output displays for use with HView Designer, you should
have discovered your HView SX Pro device using CCS Navigator (4.9 or higher) and added
the multiviewer to a Platinum or IP3 matrix.

After this intial configuration is done, the HView SW Pro automatically discovers the router's
resource card. The router's source and destinations names are available using Harris
Broadcast LRC protocol over the default port number 52116.

Each HView SX Pro 16 can drive three monitors, and each HView SX Pro 32 or 64 can drive
six monitors. All monitors must be the same pixel and frame rate, and they are synchronized
when connected to HView SX Pro.

A display profile is a description of the layouts on displays within a group. If no profiles are
available for the HView SX Pro (perhaps because it is a new device, with no profiles created)
Change Display Profile is not enabled.

Select Create Display Profile and Change Display Profile in the System section of the
Home tab to open the Display Profile tab.

Once this tab is available, you can open it by clicking on it, or close it by clicking the X in the
tab’s title.

HView Designer Harris Broadcast

i_-_l'lune

f spiny Prefile 2

(]
e

©)

Display2 Displayl

Pl AeTTeE Firene L Ay Prieser

. Mew Groum & . Horwr Sirvmm 1

Figure 5-2 Display Profile Tab
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Table 5-1 Display Profile Tab Definitions

Key

Item

Function

Display Properties

This column updates depending on the selected item in the canvas.

m Display Profile — Background is selected. These options apply to the
entire display

m Group Properties — Group is selected. These options define the whole
group.

m Group Actions — Delete the group.

Available displays

The list shows all displays associated with the device. Bright displays are
available to be added to the profile; dull displays are not available.

If your device is a HView SX Pro16, three displays are available. If it is a HView
SX Pro32 or 64, then six displays are available. As you add displays to the
profile canvas, they disappear from the Display profile list. Each display can be
added to the profile once.

Profile Canvas

Displays the currently selected displays in the profile.

Display Object

Shows a thumbnail representation of the current display profile on the
display canvas.

Current Profile

Shows descriptions of all items in the profile.

@ 0 06 0

Existing Display profiles

Lists all saved profiles.

Creating a Display Profile
1 On the Home panel, click New Display Profile.
The Display Profile tab appears and/or comes to the front.

2 Inthe Display Profile data area at the right of the dialog box, enter a name and description
for the display profile.
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You can enter or change the display profile’s name later by clicking on the background of
the canvas area. When you save the profile, it will have this name and description in the
bottom right corner of this screen.

/ HView Designer Harris Broadeast

LSRR NS Disciay Brodiie i

Dimplay Profibs 4

B tiglay Molils

Profile name and
Description

Figure 5-3 Display Profile Screen
It will also have this name and description in the Change Display Profile dialog box

3 To add displays to the profile, click Add 3 Displays or Add 6 Displays.

If you have a HView SX Pro 16, then you can add 3 displays. If you have HView SX Pro 32 or
HView SX Pro 64, you can add 6 displays.

To delete a display or group of displays from the canvas, click once on the group of displays,
and then click Delete on your keyboard, or click Delete or Delete Group under Display
Actions, or right click on the group and select Delete Display.

As you add and delete displays from the profile, the Current Profile section of the screen
updates to show information about the displays, including their size, active preset, and the
group they are assigned to.

4 Save the profile in one of the following ways:
m  Click Save to save the profile
m  Click Save as to save the profile with a different name and description

m  Click Save as Active to save the profile with its current name and description, and
update the profile on the connected displays

Setting the Active Display Profile

The active display profile is the one that is currently assigned and in use on the HView SX
Pro. You can set the active display profile from the Display Profile screen by clicking Save
as Active Profile. You can also set the active profile from the Home panel. Follow these
steps:



1

HView Designer for HView SX Pro
User Guide

Click Change Display Profile.
The following window appears:

Dinplay Profile 1
ey Bt

B Displey Profite 2

Ihamisy Prafior !

1520 = 1080 1520 = 1080 1520 x 1050

Figure 5-4 Set Active Display Dialog Box
The active profile on the HView SX Pro has a green check at its left.

Click an item in the Existing Display Profiles list to see the displays in the canvas to the
right, and a description of each display in the banner across the bottom.

Click Use this Profile to set the selected profile as the active profile on the HView SX Pro.
On this screen, you can also do the following:

m  Delete—Removes the profile from HView SX Pro and memory

m  Edit—Opens the selected profile in the Display Profile tab

Click OK to close the Set Active Display Profile screen.

Editing a Display Profile

1

In the bottom right corner of the Display Profile tab, select a profile from the Existing
Display Profiles list.

The active profile on the HView SX Pro has a green check at its left.

Click Edit.
The layout displays appear in the Display Profile canvas.

Make changes.
See Creating a Display Profile on page 45 for tools and options for display profiles.

Click one of the Save options.
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Working With Layouts

A layout is an arrangement of windows and other layout objects. Windows are containers
that are used to store a compilation or arrangement of layout objects, such as video inputs,
audio meters, and tally indicators to display video and information from the multiviewer’s
various input sources. Other layout objects include clocks, timers, backgrounds, and
stand-alone labels.

The following figure illustrates a layout comprised of windows and layout objects.

Layout Layout Object Window Component

— video
(I mput
I Panel with Audio |
Window — Border
Digital clock
- __ audio meters
Timer

Parel with Audic

Textbox or automation textbox

. — Tally

Tl — Label

Analog clock

Figure 6-1 Layout, Windows, and Layout Objects

HView Designer provides a number of different ways to create new layouts for display on
your multiviewer system. After layouts are created, you can use the editing options to define
how you want the layout to appear in output display devices.
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Use the HView Designer to modify the default assignment of video before displaying the
layout in the output display devices.

Creating New Layouts

Using the Layout Creation Wizard, you can create customized layouts starting with a
predefined layout and using objects from the library. You can then save the layout and
publish it to your multiviewer for display.

New layouts can be created “online,” which means you can take a published layout, edit it
in HView Designer, and then re-publish it.

New layouts can be created “offline,” which means that you can use HView Designer to
create a layout, save it to a network or local drive, and then publish it to a connected
multiviewer at a later time. You do not need to be connected to a multiviewer to create and
edit layouts.

1 From the HView Designer Home tab, do either of the following:
m  Click New Layout Using Template

m  With a display that has no active preset (so the central region of the Home tab looks
like Figure 6-2), click Create New Layout.

/ HView Deslaner Harris Brosdcast
i TN ary © Handware Config < Display Profile -

W diew Laymd uney Template

Fangs hrires Lapo

® narthears Confguranan

gt

g Eeabde: 0T

Figure 6-2 Display 2 Has No Active Preset

m Click Change Active Layout, and then click Create New Layout.
The New Layout dialog box opens.
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St
Dl | Prwart |

Tempias Bt

Input O

Figure 6-3 New Layout Dialog Box

From the Display Profile Configurations list, choose a display.
Click on a template to select it.

A thumbnail of the window that will be used to populate the template is shown at the
bottom of the dialog box. To the right of the window is a brief description of the window
and a button indicating the currently selected aspect ratio.

To change the aspect ratio of the window, click the aspect ratio button. Options include:
m  Free (the width and height of the window can be changed independently)

m 169

s 14:9

s 43

If you want to change the window:

a Click Change Window.
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Figure 6-4 Available Windows Dialog Box

b Select the window you want to use.
¢ (Optional) Click Change Template to return to the template selection screen.

Some combinations of layout and window may be disabled, due to unavailable space in the
layout for all the window's elements. If your combination will result in an unacceptable
layout, a message will appear at the bottom of the dialog box.

Select a setting for Template mode.
m  Off—you will be able to freely add or remove layout items in the Layout editor.

m  On—you will be able to drag and drop new items to replace old ones in the Layout
editor. Items can only be moved or resized within the grid boundary.

Once the layout is created, you will have options to change the template mode to either

m  Manual mode—Items are dropped at the cursor point
= Auto mode—Items are auto-placed from left to right, top to bottom

Once a layout stops being in Template mode, you cannot return it to that state.
Click Create Layout.
If the Create Layout button is unavailable, it may be due to an inappropriate combination

of window and layout. Change one of these options to a simpler selection. The button will
return to availability.
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The new layout opens in the Editor tab. Each region of the layout is populated by the
selected window.

/ HView Designer Harris Broadcast
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Figure 6-5 Editor Tab for a New Layout

Duplicate Windows are only seen in Wide band mode. In Multi viewer mode you do not see
duplicates. See Creating a New Routing Matrix on page 26 for more information.

8 Modify the layout.
See Using Layout Editor on page 54.

9 From the Preset menu, select a preset to assign the layout to.

If there is already a layout in the selected preset slot, you will be asked if you want to
overwrite that preset.

10 To save the layout do one of the following:
m  Click Save to save the layout to the selected preset.

m  Click Save as Active to save the layout to the selected preset and display this preset on
Hview SX Pro output.

m  Click Export to save the layout to the current PC or to another network location.

Opening a Layout for Editing

You can always edit the active layout for the selected display by clicking Edit Active
Layout. To choose a different layout for editing, follow these steps:

1 Select a display.
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Indicates the

indicates the
selected layout

Toggles Full view
and Group view

2 Click Change Active Layout.
The Change Active Layout dialog box opens.

Thaspd At vt

Duplicate 1

Duplicate 3

Input 5

Duplicate 2

Duplicate 4

Figure 6-6 Change Active Layout Dialog Box

Select a preset from the list on the left.
The display at the center of the screen updates to show the layouts involved in that preset.

Input &6

Click a layout and then click Set Full View to see that layout in full-screen. Click Revert to
Group View to see all layouts (there will be three layouts with HView SX Pro-16 and HView

SX Pro-8x3-28 modules).

Click Edit Layout.

The Set Active Layout dialog box closes and the layout opens in the Layout Editor tab.

You can now make changes to the layout and save it as described in Using Layout

Editor on page 54.

Using Layout Editor

When you create a new layout or open a layout for editing, it opens in the Editor tab. Only
one layout at a time can be open for editing.
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Figure 6-7 illustrates an overview of Layout editor options and controls.

HView Designer
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Figure 6-7 Using HView Designer Controls and Options
0 Selection tools. See Tool Palette on page 56.
9 Layout canvas. For more information, see Adjusting the Layout Canvas on page 58.
e Display controls. For more information, see Display Controls on page 57.

a Modify object properties for the selected item. See Editing Window Components on
page 67 and Editing Layout Component Properties on page 63.

6 Library objects. The Layout Editor’s library panel only shows objects available to layouts.
See Working With Libraries in HView Designer on page 83.

@ Save options. See Save Controls on page 58.

§ You can drag and drop objects from the library to the canvas.
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Tool Palette

Table 6-1 Tool Palette

The tool palette at the left side of the screen provides access to common functions

I

Tool Name Function
Pip window Selects a window object. When a window object is
f\,‘ selection selected, you can edit the general components of that

window, including alarms assigned to it, its position, and
its source properties. Objects selected with this tool have a
dotted red outline.

Click and hold the mouse button while dragging the
mouse to select multiple items, or hold the SHIFT key and
click on multiple items.

Pip sub-widget
item selector

Selects a component of a window, such as a video input,
label, tally, audio meter, clock, or timer. When a
component is selected, you can edit its unique properties. If
this tool is not available, select a window and then try
again.

Objects selected with this tool have a yellow outline. See
Using Component Mode on page 71.

Zoom Click the left mouse button to zoom in.
ﬂ Hold the Ctrl key and click the left mouse button to zoom
out.
Zoom In Left mouse button zooms in
E Zoom Out Left mouse button zooms out
Pan Use the pan tool to move the view of the section of the

layout while zoomed in on a layout.

Select Window

Opens the Window library,
which contains windows
and standalone labels that
can be added to the layout.

Select Clock

Opens the Clock library,
which contains various styles
of digital and analog clocks
that can be added to the
layout.

Note: the library pane must
be enabled in the View
menu to see these libraries.

Select Timer

See Adding Objects to the

Opens the Timer library, Layout on page 59.

with up and down timers
that can be added to the
layout.

B 0O B 0B

Select Alarm

Opens the Alarm Templates
library.
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Table 6-2 Display Controls
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Button

Description

Function

328% -

Zoom Level

Click to choose a zoom level. The button indicates
the current level.

Zoom to Fit

Zoom to Fit

The button resizes the layout to fill the display
space provided.

View -

View Menu

Menu turns on or off extra display elements.
The View menu contains the following options:

m View Grid (Q)—Turns on/off a crosshatch
background to aid in aligning objects. This is
more useful when there are less things on the
layout.

m View rulers—Turns on or off the rulers on the
left and top of the canvas. When rulers are
visible you can add guides to the layout.

m View Library pane—Turns on or off the library
pane at the bottom of the screen. See Using the
Library Panel on page 60.

m View Property pane—Opens or closes the
property pane at the right of the screen. See
Adjusting Layout Properties on page 59 and
Editing Layout Component Properties on
page 63.

m View Guides—Turns on or off guides, if there
are any. This is independent of the View Rulers
option which allows you to add guides. See
Using Guides on page 62.

Edit Menu

The Edit menu contains the following options:

m Undo—Undoes up to the last 25 actions.

m Redo—Redoes the most recently undone action
m Delete—Removes the currently selected item.

m Select All (CTRL A)

m Unselect All (CTRL space)

m Copy Window (CTRL C)

m Paste Window (Ctrl V)
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Table 6-2 Display Controls (Continued)

Button Description Function

Format Menu The Format menu setting determines editor mode
for behavior for adding items to the layout:
(displays the

= Auto Format—Items are auto-placed from left
format state)

to right, top to bottom

Manual Manual Format—Items are dropped where the

cursor points

Template ~ » Template Format— Items can only be replaced,

moved or resized within the grid boundary

Once you switch from Template Format, it is no
long available.

: . Show Routing / Toggles display of the actual video input or the
Sl | Show Video Input | name of the video input on the display.

Save
Controls Table 6-3 Save Controls
Button Description Function
Save Saves the current layout to the selected preset
on the HView SX Pro
Save as Active Saves the layout to the selected preset and
displays this preset on the HView SX Pro
output.
Preset Assigns the layout to one of the presets on the
HView SX Pro. The active preset is indicated in
this menu with an asterisk.
Import Opens a layout from a local (non-HView SX Pro)
location, such as a server, local PC drive, or
removable storage.
Export Saves the layout to a local (non-HView SX Pro)
location, such as a server, local PC drive, or

removable storage.

Adjusting the Layout Canvas

You can drag the dividing line between the Library pane or Property pane and the canvas,
making the canvas larger or smaller. You can also increase the view of the layout canvas by
disabling the view of the Library and/or Properties pane.

1 Hover the mouse over the line between the screen areas.

The mouse turns to a pair of arrows, indicating you can drag up and down (library pane), or
left and right (Property pane).

2 Click the mouse.
The dividing line between the two screens turns blue.

3 Do either of the following:
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m  While holding the mouse button down, drag the mouse in the directions indicated by
the arrows of the mouse, and then release.

m  Use the keyboard arrows to move the divider in the available directions.

Items in the Library and Property windows arrange themselves to best use the space
available when the cursor is dropped.

Adjusting Layout Properties

To open the Layout Properties and Alarm palettes, click on the layout background. These

palettes are described in Table 6-4 and Table 6-5.

Grey rows are read-only.

Table 6-4 Layout Properties

Item

Function

Preset

Displays the preset that is assigned to this layout.

Name

Enter a descriptive title for the layout; this title will help define the
layout in other regions of the interface.

Background

If no graphical background has been assigned, this field shows the
hex description of the solid color background. The color code is an
eight-character hexadecimal value representing the alpha and
colors red, green, and blue with (##AARRGGBB). For example, the
color of red, the color code is #FFFFO000, which is ‘255" alpha,
‘255" red,'0'green, and ‘0" blue. The alpha channel which is the
level of transparency is normally set to FF or '255'

If a graphical background has been assigned to the layout from
the library, then the file name for the background is displayed.

Width

The X axis size of the layout; the size of the layout will match the
selected output video standard resolution.

Height

The Y axis size of the layout; the size of the layout will match the
selected output video standard resolution.

Table 6-5 Layout Alarm Properties

Item

Function

Alarm Enabled

All layout alarms and alarms actions can be disabled for
troubleshooting purposes and then enabled again retaining
previous alarms settings.

Adding Objects to the Layout

Obijects are added to the layout from the library.To add an object to the canvas, follow these

steps:

1 If the library is not open, first open it by selecting View > View Library Pane from the bar

above the layout canvas.
2 Select the correct library by doing either of the following:
m  Select an item type on the tool palette.
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2
3

m  Select from the menu in the top left of the Library panel.

If you select All, then all objects that can be added to the layout are displayed in the
library. Other libraries offer a more limited selection. At no time will the library offer
items such as widgets that cannot be added independently to the layout. Objects that
can be added include:

In the library, select the specific object and drag it to the layout canvas.
New items always start out in the top left corner of the layout.

Using the Library Panel

The library panel contains all the elements that can be added to a layout.

If the Library panel does not appear in the Editor tab, open it by selecting View > View
Library Panel from the top of the screen. You can expand or contract the Library panel by
hovering the mouse over the middle of the top of the panel until the mouse displays a
double-pointed arrow. Click and drag the cursor up or down, and then release when the
panel is at the size you want.

From the Library menu, the following sub-menus are available:

m  All—Displays all elements available to add to a layout.

m  Windows—Displays groups of elements. You can also make custom windows. See
Creating Windows on page 87.

m  Backgrounds—Displays backgrounds. By default, HView Designer has some generic
backgrounds. You can add your own custom backgrounds. See Adding and
Removing Backgrounds on page 86.

m  Clocks—Shows all clocks, both analog and digital. You can also make custom digital
clocks. See Editing Clocks on page 101.

You can add up to 12 clocks to layouts within a group on an HView SX Pro system.

= Alarm Templates—Shows all alarm templates that have been created. You can also
customize alarm templates. See Working with Alarms and Alarm Templates on
page 104.

m  Timers—Contains an up timer and a down timer. See Editing a Timer on page 64.
For best results, do not add more than 10 timers to layouts in an HView SX Pro system.

Adding a Background to the Layout Canvas

The background of your layout can be an image, or it can be a solid color. See the following
topics:

m Adding a Graphical Background on page 60
m  Using the Color Selector Dialog Box on page 61

Adding a Graphical Background

You can add any image stored in the library as the background to your layout. Follow these
steps:

If the library is not already open, select View > View Library Pane from the button bar at
the top of the screen.

(Optional) From the Library menu, select Backgrounds.
With your mouse, click on a background and drag it to the layout.
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The layout updates to show the background behind all layout objects.

For information on adding graphics to the Background Library, see Adding and Removing
Backgrounds on page 86.

Using the Color Selector Dialog Box

Right click on the background of the layout and select Change Background Color. The
Color Selector dialog box opens to assign a color to the background.

Colour Selector

255

# FF296FBE

oK

Figure 6-8 Color Selector Dialog Box
To choose a color:

1 Choose a hue using the slider bar.
2 In the shade region of the screen, click the shade you want.
You can also enter the RGB numbers of your color.

§ Alpha channel (A) is the level of transparency and is normally set to FF or ‘255",
The palette in the top right of the dialog box updates to show your color.

3 Click OK.
The background changes to the selected color.

Moving Objects on the Layout Canvas

With the Selection tool active (see Tool Palette on page 56) click an object on the Layout
Canvas, then while holding down the mouse button, drag the mouse to move a window.

You can move multiple objects by holding the Shift button and clicking on individual
objects, or by holding down the mouse while dragging a rectangle around the objects to be
selected.

The selected object in the layout canvas has a red dotted border and small blue squares on
its corners and sides. To resize an object, click any of the small blue squares, hold down the
mouse button and drag to resize the window. The window is resized proportionally.

When you click on an object in the layout and drag it, it will snap to the guides, or to other
objects in the layout.

You cannot drag an object off the layout area or position it partially on the layout area. All
objects must be entirely within the layout.
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Using Guides

If you have rulers open on the layout, roll the mouse over the ruler and click to add guides
to the layout.

Adding Guides

To add a guide, follow these steps:

If rulers are not visible at the top and left of the layout canvas, select View > View Rulers
to make them visible.

From the View menu, select View Guides.
If there are guides already on the layout, they become visible.

Click the mouse on the ruler at the point where you want a guide to appear.
A red line appears on the layout canvas.

Moving Guides

To select a guide, drag the mouse across any point on the background over the guide (do
not click and start to drag over a window or other layout element, as that element will be
selected).

The guide gets a red dotted line around it. The mouse pointer turns to a pointing finger
icon.

&)

Figure 6-9 Pointing Finger Icon

To reposition the guide, click and drag the handle on the guide with your mouse, and then
release when the guide is positioned how you want it.

Deleting Guides

To delete a guide, follow these steps:

Drag the mouse across any point on the background over the guide to select the guide.
Press Delete on your keyboard.
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Editing Layout Component Properties

When you click on a non-Window object in the layout canvas with the Pip Window
selection tool, the following options appear:

Editing a
Clock

Table 6-6 \Window General Properties

Parameter

Function/Range

Name

You can enter a descriptive name for the window as a whole

ID

(Read-only) A numeric index, only appears for objects that can be
connected to another object, such as a timer.

Top

The position of the top edge of the window in reference to the left
edge of the layout; you can move the window by changing this number

Left

The position of the top edge of the window in reference to the top of
the layout; you can move the window by changing this number

Width

The X axis size of the window; you can resize the window by changing
this number. If you change the number and click Enter, the height is
changed proportionally. To change just the width of the window, press
Shift + Enter to confirm the change.

Height

The Y axis size of the window; you can resize the window by changing
this number. f you change the number and click Enter, the width is
changed proportionally. To change just the height of the window,
press Shift + Enter to confirm the change.

Right Click Options with the Pip Window Selection Tool

When you right-click a window or other layout element with the Pip Window selection tool,
you have these options:

m  Copy Window—-Places all the properties of the selected window except its size and
position on the clipboard.

m  Paste Window Properties—Applies all window properties except the window size
and position to the selected window. (Audio meters are included in the paste only
when the two windows have the same number of audio meters.)

m  Paste Alarm Properties Only—Applies only the alarm settings from the copied
window to the selected window.

m  Edit Window Style—Opens the selected window in the Window editor. See Copy
and paste options include metadata, alarms, etc. on page 79.

m  Set Component View—In this mode, you can edit elements of the selected window.
Copy and paste options include metadata, alarms, etc.

Digital and analog clocks have the same options. When you add a clock to a layout, it has
the time zone properties of your PC.
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A clock is not a window element, so if you click on it with the Pip Sub-Widget item selection
tool, you will see the options described in Table 6-11:

Table 6-7 Clock Component Properties

Item Options

Time Source System— Use the multiviewer’s internal time as a reference
source for the selected clock.

LTC— Uses an external source as the clock reference source
such as the LTC input.

Clock Offset Choose a number between -12 to +13 hours from the first
menu, and 00 m or 30 m (minutes) from the second.

Editing a  Atimercan be up or down. Timers are in HH:MM:SS format (hours, minutes, and
Timer seconds).When you click on a timer with the Pip Sub-Widget item selection tool, the
following options appear in the Object Properties panel:

Table 6-8 Timer Component Properties

Item Function
ID The ID is used for reference for control using SNMP or CCSP.
Source System— Use the multiviewer's internal time or an NTP source

as the reference source for the selected clock.
LTC— Uses an external source as the clock reference source such
as the LTC input.

Time The initial starting time of the timer. To set the time, do either of
the following:

m Click on the hour, minute or second and type the value in

m Click on the hour, minute or second and use the increment
buttons

m Click on the clock-face and use slider controls

Alert Time The time at which the timer blinks.

Warning Time The time at which the timer turns red.

Editing a Standalone Label

When you click on a standalone text label with the Pip Sub-Widget item selection tool, the
following options appear in the Object Properties panel:

Table 6-9 Standalone Label Properties

Item Function
Label Source Choose Fixed.
Text Enter text for the label.

Standalone labels do not have an ID to associate with a window component, and their
source is always fixed (static).
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Editing an Automation Label

Editing a
Window

Il

When you click on an automation text label with the Pip Sub-Widget item selection tool,
the following options appear in the Object Properties panel:

Table 6-10 Automation Label Properties

Item Function
Label Source Choose Automation.
Message ID Configure these fields based on the settings for your

automation system. See Appendix C for sample

Sub ID ) .
configurations.

Automation labels do not have an ID to associate with a window component, and their
source is always fixed (static).

When a window is added to a layout, you can change its size and position and some
properties elements of that window. You cannot change the elements that are in the
window within the layout. For that, you need the Window Editor. For information on
using the Window Editor, see Reopening a Window or Textbox for Modification on
page 100.

When you click on a window with the Pip Window selection tool, you can move that
window.

Resizing a Window

To resize a window, Follow these steps:

Hover the mouse over a control point on the selected window until the mouse becomes a
bidirectional arrow.

Click the mouse and drag.

The window can be resized in the directions of the two arrows. Hold the Shift key down to
constrain the window to its current aspect ratio.

For best results, do not allow video windows to layer on top of each other. This can lead to
video artifacts.

Editing Window Properties

When you click on a window with the Pip Window selection tool, the Modify Object
Properties column at the right of the screen updates to show window options, as described
in Table 6-11.

Table 6-11 Window Properties

Parameter Function/Range

General

Name You can enter a descriptive name for the window as a whole
ID A numeric index
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Table 6-11 Window Properties (Continued)

Parameter

Function/Range

Video Input

The drop-down menu lists all the available video inputs. If your HView
SX Pro is configured with a Wideband matrix, the list also contains a
duplicate of each available input.

Each input that is in use in the preset has an indicator:

o

The number in the middle of the indicator represents the display the
input is used in within the preset. If the indicator is yellow, the input is
used on the current display, while if it is white, it is used in a different
display within the preset.

Each input or duplicate input can be used once per preset.

Top

The position of the top edge of the window in reference to the left
edge of the layout; you can move the window by changing this number

Left

The position of the top edge of the window in reference to the top of
the layout; you can move the window by changing this number

Width

The X axis size of the window; you can resize the window by changing
this number. If you change the number and click Enter, the height is
changed proportionally. To change just the width of the window, press
Shift + Enter to confirm the change.

Height

The Y axis size of the window; you can resize the window by changing
this number. f you change the number and click Enter, the width is
changed proportionally. To change just the height of the window,
press Shift + Enter to confirm the change.

Aspect Ratio

Choose the aspect ratio; options include:

m Free (the width and height of the window can be changed
independently)

m 169
m 149
m 43

Alarm Properties

See Working with Alarms on page 39 for a complete description of using alarms.

Routing Properties

Enabled

When checked, HView SX Pro controls routing of the video input.
When unchecked, an external system, such as IconMaster controls the
router for that video input.

Audio Routing Properties

Enabled

When checked, HView SX Pro controls routing of the audio input.
When unchecked, an external system, such as IconMaster controls the
router for that audio input.

When you click on an element in a window with the pip sub-widget item selection tool,
that element’s component properties appear. See the following:

m Editing Video Properties on page 68
m Editing Label Properties on page 77
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m  Editing Tally Properties on page 78
m Editing Audio Meter Properties on page 78

Editing a Group of Windows

To select multiple windows, hold the mouse button down and drag across the windows you
want to select, or hold the Shift key down and click on individual windows. You can then
resize or move all the windows the same way you would alter an individual window.

=

When multiple windows are selected, only fields that have the same data will be filled. If
you change a field, whether it is filled or not, all windows in the group will be updated.

Table 6-12 Right-click Options on Group Selections

Option

Function

Paste Window Properties to All

This option is only available when Window
Properties have been copied to the clipboard.

(Audio meters are included in the paste only when
the two windows have the same number of audio
meters).

Paste Alarm Properties Only to All

Pastes only the alarm properties from the window
where all Window Properties have been copied to
the clipboard.

Align Everything Left

Aligns all selected windows to the left edge of the
leftmost selected window.

Align Everything Right

Aligns all selected windows to the right edge of the
rightmost selected window.

Align Everything Top

Aligns all selected windows to the top edge of the
topmost selected window.

Align Everything Bottom

Aligns all selected windows to the bottom edge of
the bottom most selected window.

Distribute Horizontally Across
Layout

Does not alter the positions of the selected windows
in the vertical plane, but aligns them evenly across
the layout.

Distribute Vertically Across Layout

Does not alter the positions of the selected windows
in the horizontal plane, but aligns them evenly from
the top to the bottom of the layout.

Make Same Size as First One

Resets the size of all selected windows so they
match the size of the first selected window.

Note: These alignment options will not prevent video windows from layering on top of each
other. For best results, do not allow video windows to overlap each other. This can lead to

video artifacts.

Editing Window Components

To modify elements of a window such as video properties, labels, audio bars, etc., you must
first put the window in component view.
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To enter component view, do either of the following:

m  Click on a window with the PiP window selection tool and then click component with
the pip sub-widget item selection tool.

m  Double-click on a PiP with the PiP window selection tool.

Click to modify the
video properties

Click to exit
Component mode

Click to modify the
label properties

Click to view tally
properties

Figure 6-10 Component View
This view makes it clear what window you are selecting objects from.

To exit Component View mode, click the button in the middle of the window.

Editing Video Properties

Video properties are divided into seven separate palettes. Each palette has an arrow in its
top left corner that you can use to open or close it.

Table 6-13 Video Properties

Item Function
Video
Name Enter text you want to have associated with the video; this

can be used for search purposes

ID The ID identifies the internal scaling unit associated with
that video input, to tie it with other window resources.
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Table 6-13 Video Properties (Continued)

Item

Function

Video Input

The drop-down menu lists all the available video inputs. If
your HView SX Pro is configured with a Wideband matrix,
the list also contains a duplicate of each available input.

Each input that is in use in the preset has an indicator:

o

The number in the middle of the indicator represents the
display the input is used in within the preset. If the
indicator is yellow, the input is used on the current
display, while if it is white, it is used in a different display
within the preset.

Each input or duplicate input can be used once per preset.

General

Height

Size of the y axis of the space for the video, measured in
pixels.

Width

Size of the x axis of the space for the video, measured in
pixels.

Video Metadata

(Choose from the drop-down menu)

None
CC 608 CC Modes
m CC1—CC4
cC 708 CC Modes
m Service 1 —6
Timecode = VITC/ATC
m Left/Right/ Center screen position
= Small / Large text size
s Row 1 —15
When VITC is selected When ATC is
= VBI Line 8 to 22 selected
m - ATC_VITC1
m - ATC_VITC2
m - ATC_LTC
Teletext m TT Mode — OP47 or WST

m Subtitles Page —The page number determines the
Teletext page that is expected to be displayed. The
range is 0 to 999 (801 is the default for OP-47 closed
captioning).
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Table 6-13 Video Properties (Continued)

Item Function

Video Borders o _ _
When video borders is set to Enabled, a gray border is displayed on the video section of

the selected window of the layout

Window with
video border
enabled

LRC Source

Enab|e | | Checked
m Unchecked
Size 1-10

Video Safe Area
When video safe area is Enabled, a darker blue border indicating the selected safe area
size is displayed on the selected window

Window with

Input 2 enabled

LRC Source

Enable m Checked
m Unchecked
Size 10 - 95%

Aspect Ratio markers . _
When aspect ratio markers is Enabled, the selected aspect ratio markers are displayed on

the window of the layout

Window with
safe area

In put 3 enabled

LRC Source
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Table 6-13 Video Properties (Continued)

Item

Function

Enable

m Checked
m Unchecked

Ratio

Select the aspect ratio markers:
m 4.3

m 14:9

m 169

Color

Click the button to determine the color of the markers.
The color selector tool works similarly to the color selector
for the layout background, except the alpha channel
provides transparency. See Using the Color Selector
Dialog Box on page 61.

Width

Set the thickness of the marker, from 1-10 pixels.

Detect Aspect Ratio

Force PiP AR m Off — scales video to PiP size
m Detect Aspect Ratio — scales PiPs based on detected
information
Force PiP AR = Standard Based
(only available when Force s AFD
PiP AR is set to Detect
Aspect Ratio) WSS
m Vi
Line selection SD525
(only available when VI. is Range: 12 — 19 (14)
selected under Force PiP AR)
SD625
Range: 8 — 22 (11)
SD = 16:9
(only available when Force m 149
PiP AR is set to Detect . 43
Aspect Ratio) '
HD = 169
(only available when Force
PiP AR is set to Detect
Aspect Ratio)
Video Cropping
Enable n Off
m On
X-Offset (%)
Y-Offset (%)
0-100

Crop Width (%)

Crop Height (%)
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Table 6-13 Video Properties (Continued)

Item Function
s HD 720

(note th|§ field is for = SD 720x486
informational purposes only

and in the absence of video |® SD720x576
input will default to HD 1080)

X Pixel Offset These read-only fields update to indicate the dimensions
. of the window based on settings made in the offset and
Y Pixel Offset .
crop fields above.
Pixel Width

Pixel Height

Configuring Video Indexing

Configure Video Indexing on individual PiPs using the Aspect Ratio parameters in
Table 6-13. Video Indexing in HView SX Pro is compliant with the following standards:

m  RP 186 -2008
= SMPTE 125
s SMPTE ST 2016-1 and SMPTE ST 2016-3

HView SX Pro implements class 1.1 data octet 1 (Scanning System Data Field and Active
Format Description) on 525 and 625.

Configuring Aspect Ratio (AR) settings

For AFD, VI, and WSS, if the coded frame matches the PiP AR, then video is anamorphically
stretched with no other AR processing. (E.g. cropping or deleting video):

m  SD input (4:3 system) to 4:3 PiP
m  SDinput (16:9 system) to 16:9 PiP
If the coded frame does not match the PiP AR, AR processing is required:

m  SDinput (4:3 system) to 16:9 PiP
m  SDinput (16:9 system) to 4:3 PiP

The Image is scaled with no geometric distortion and Letter box/pillar box is applied as
required. The PiP’s physical size stays the same. Only the scaling inside the PiP changes.
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The AFD shapes in Table 6-14 and Table 6-15 are common for VI AFD, WSS, and AFD.

Table 6-14 16:9 Scanning (AFD)

AFD Code PiP AR 16:9
1000

VI 16:9 Full Frame VI 16:9 Full Frame
1011

VI 16:9 Box 14:9 (center) VI 16:9 Box 14:9 (center)
0100

VI 16:9 Box>16:9 (center) VI 16:9 Box>16:9 (center)
1001

VI 16:9 4:3 (center) VI 16:9 4:3 (center)
1010

VI 16:9 16:9 (protected) VI 16:9 16:9 (protected)
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Table 6-14 16:9 Scanning (AFD) (Continued)

AFD Code |PiP AR 16:9 PiP AR 4:3
1101

VI 16:9 4:3 (a 14:9 center) VI 16:9 4:3 (a 14:9 center)
1110

VI 16:9 16:9 (a 14:9 center) VI 16:9 16:9 (a 14:9 center)
1111

VI 16:9 16:9 (a 4:3 center) VI 16:9 16:9 (a 4:3 center)
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AFD Code PiP AR 4:3 PiP AR 16:9
0010

VI 4:3 Box 16:9 (top) VI 4:3 Box 16:9 (top)
0011

VI 4:3 Box 14:9 (top) VI 4:3 Box 14:9 (top)
0100

VI 4:3 Box>16:9 (center) VI 4:3 Box>16:9 (center)
1000

VI 4:3 Full Frame VI 4:3 Full Frame
1010

VI 4:3 16:9 (center) VI 4:3 16:9 (center)
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Table 6-15 4:3 Scanning (AFD) (Continued)

AFD Code PiP AR 4:3 PiP AR 16:9
1011
VI 4:3 14:9 (center) VI 4:3 14:9 (center)
1101
VI 4:3 4:3 (a 14:9 center) VI 4:3 4:3 (a 14:9 center)
1110
VI 4:3 16:9 (a 14:9 center) VI 4:3 16:9 (a 14:9 center)
HH _
VI 4:3 16:9 (a 4:3 center) VI 4:3 16:9 (a 4:3 center)
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Depending on the source you select for the label, different options become available.

Table 6-16 Editing a Label

Item

Function

Label Source

m Fixed—Label displays the contents of the Text field.

m UMD—Label displays data provided from either the
routing database or an external UMD protocol,
associated with the parent window’s ID, and further
specified by the UMD Source parameter.

m Video Standard—Label displays the video standard of
the video input source.

m Aspect Ratio—Label displays the aspect ratio of the
video component of the window.

m VChip—Displays the V-Chip rating that is contained in
the video stream’s metadata.

m Closed Caption—Label indicates the presence or
absence of CC 608 and CC 708 captions.

m Automation—Displays information provided by an
A8100 D-series automation system, based on
information provided with the Message ID and Sub
ID parameters. See Configuring A8100 D-Series
Automation on page 154.

m Teletext—Displays Closed Caption or other metadata
information. See Table 6-13 on page 68.

UMD source

When the Label Source is set to UMD, this option helps
define the label contents:

m Primary—Displays primary UMD from the external
UMD protocol

m Secondary—Displays the secondary UMD from the

external UMD protocol that supports secondary UMDs.

m LRC Source—Displays the source UMD from the
Logical Router database.

m LRC Destination—Displays the destination UMD from
the Logical router database

Text

Using a standard keyboard, enter text that will appear if
the Label Source is Fixed.

Message ID

Sub ID

When the Label Source is set to Automation, this
option helps define the label contents. See Label Source
and UMD ID in HView SX Pro on page 155.
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Editing Tally Properties
The Tally Object Properties palette is for information purposes only. Tallies are defined at the

time when the window is created, and the IDs are associated with the contents of the
window. See Modifying a Tally in the Window Editor on page 96.

Table 6-17 Editing a Tally

Item Function

Type = Red ta”y
Green tally

Yellow tally

Blue tally

ID The ID identifies the internal scaling unit associated with
that video input, to tie it with other window resources.

State m Off
m On

Editing Audio Meter Properties

The audio meters always monitor the audio associated with the video input to the window.

Table 6-18 Audio Meter Component Properties

Item Function

Channels By default, Embedded Audio channels 1 - 4 are listed.

Add Embedded: Adds the next available embedded channel.
Add Discrete: Adds the next available TDM channel. Note:
TDM is not currently supported.

Neither add button will add a channel that is already selected on
the window, whether in this audio meter or any other audio
meter that might be associated with the window.

To change the channel, click the channel’s label and all channels
of that type are displayed (either embedded or TDM. Note: TDM
is not currently supported).

Up/Down: Moves the audio channel up or down one level in
the list.

Del: Deletes the channel.

Bar Width The width of the individual audio channel indicators within the
audio meter.
Spacing The space between the individual channels filled in with

background on the audio meter.

Show Graticule When checked, audio meter scale indicators are displayed.

Right Click Options with the Pip Sub-Widget Item Selection Tool

When you right-click a window or other layout element with the Pip Sub-Widget item
selection tool, you have these options:



Using the
Alarms Panel

HView Designer for HView SX Pro
User Guide

m  Copy Window Properties—Places all the properties of the selected window except its
size and position on the clipboard.

m  Paste Window Properties—Applies all window properties except the window size
and position to the selected window. (Audio meters are included in the paste only
when the two windows have the same number of audio meters.)

m  Paste Alarm Properties Only—Applies only the alarm settings from the copied
window to the selected window.

m  Edit Window Style—Opens the selected window in the Window editor. See
Reopening a Window or Textbox for Modification on page 100.
You must close the Window editor before you can return to modifying the layout in the
layout editor. The window that is in modification turns yellow and flashes "in editing"
to indicate that it is undergoing modification.
When you modify the window, you will have various save options, including replacing
the window style just the selected layout, or replacing all windows that have the same
window style within all layouts. You must close the Window editor if you want to
continue editing your layout.

m  Set Component View—In this mode, you can edit elements of the selected window.
Copy and paste options include metadata, alarms, etc.

When you add or select an object in a layout within the Layout Editor screen, the Alarm
Properties panel appears.

® Alarm Properties

© Video Alarm
© Video Alarm Action
© Audio Alarm

© Audio Alarm Action

Figure 6-11 Alarm Properties Panel

Enable/Disable Alarms

Alarms are enabled or disabled for the entire layout at the same time. To change the setting
for a layout, follow these steps:

Click on the background of the layout in the Editor tab.

In the Property Pane at the right of the screen, click beside Alarm Enabled (found under
Alarms).

Now, when you click a window and then select an option under Alarm Properties, that

option indicates, at the top of its properties list, that the Enabled status for that alarm is
True or False.
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Configuring Alarms Settings

A row that is grey in the table indicates that setting is read-only and cannot be changed.

Table 6-19 Video Alarms

Item Function Range
Enabled When unchecked, no alarms will be triggered for the video. |® True
m False
Black Picture Triggers an alarm when the video is black for a period of = Checked
time, as defined by the Black picture level, Black picture | g Unchecked
percent, and Black picture time parameters in the alarms
section of the Hardware Configuration. See Table 4-2 on
page 16.
Frozen Picture Triggers an alarm when the video is frozen for a period of = Checked
time, as defined by the Frozen picture level and Frozen a Unchecked
picture time parameters. See Table 4-2 on page 16.
Loss of Sync Video is not in sync for a period of time defined by the Loss | ® Checked
of video sync parameter. See Table 4-2 on page 16. a Unchecked
Loss of CC Closed captioning data is not present on the signal = Checked
= Unchecked
Loss of VCHIP VCHIP data is not present on the signal m Checked
= Unchecked
Loss of ATC ATC data is not present on the signal m Checked
m Unchecked
Loss of VITC VITC is not present on the signal = Checked
= Unchecked
Table 6-20 Video Alarm Actions
Item Function Range
Enabled When unchecked, no alarm response will be triggered for = True
the video. m False
Visual Display Indicates on the layout when an alarm is triggered. Settings |® Checked
within the layout itself determine how the alarm is indicated. | @ Unchecked
See Adjusting Layout Properties on page 59.
SNMP Message Posts the alarm to the SNMP client on the system when the |® Checked
alarm is triggered = Unchecked
GPO Response Triggers a GPO when the alarm is triggered m Checked
= Unchecked
CCSP Notification Sends a message over the CCS P network when an alarm is | ® Checked
triggered m Unchecked




Table 6-21 Audio Alarms
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Item Function Range
Enabled When unchecked, no alarms will be triggered for the audio. |® True
m False
Channels Selects which channels the alarms are enabled on. 1-16
TDM Channels Selects which TDM channels the alarms are enabled on. 1-8
Note: TDM is not currently supported.
Audio Over Triggers an alarm when the audio is loud for a period of m Checked
time, as defined by the Audio over level and Audio over | & Unchecked
time parameters. See Table 4-2 on page 16.
Audio Under Triggers an alarm when the audio is quiet for a period of m Checked
time, as defined by the Audio under level and Audio s Unchecked
under time parameters. See Table 4-2 on page 16.
Audio Loss Triggers an alarm when the audio carrier (AES/EBU framing) |® Checked
is lost or invalid. s Unchecked
Table 6-22 Audio Alarm Actions
Item Function Range
Enabled When unchecked, no alarm response will be triggered for | = True
the audio. m False
Visual Display Indicates on the layout when an alarm is triggered. Settings | ® Checked
within the layout itself determine how the alarm is s Unchecked
indicated. See Adjusting Layout Properties on page 59.
SNMP Message Posts the alarm to the SNMP client on the system when the | ® Checked
alarm is triggered s Unchecked
CCSP Notification Sends a message over the CCS P network when an alarmis |® Checked
triggered = Unchecked
GPO Response Triggers a GPO when the alarm is triggered = Checked
= Unchecked

H W IN =

Applying an Alarm Template

To apply an alarm template to a window, follow these steps:

In the layout editor, drag an alarm template from the Library.

Drop it on a Window.

A window can only have one alarm template applied at a time.

You can also apply a series of alarms to a window using the right-click context menu.

Right click on a window.

Select Copy window properties.
Right click on another window.
Select Paste alarm properties only.
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7]  Working With Libraries in
HView Designer

Using Libraries
When you click on View and Edit Library in the HView Designer Home page, all library

objects are visible. The Library differs from a library panel in the Layout editor or Window
editor, because here new items can be created to add to any layout.

Harris Brosdeast

Input O Input O

Wideg, WEs, e e kD

WVides et ardd 1 (3] @

Input 0 Input O

Input 0 Input 0

wien, lamel 1milen arad 1

[pe—
e s

Ay
& Add hew Alarm Temglale

Embgrd

P -

las kg §

Figure 7-1 Library
From the Library menu, the following sub-menus are available:

m  All—Displays all elements in all libraries.

m  Windows—Displays groups of elements.

m  Backgrounds—Displays backgrounds.

m  Clocks—Shows all clocks, both analog and digital.

= Alarm Templates—Shows all alarm templates that have been created.
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Searching a
Library

Viewing
Library
Items

Library
Properties

m  Window Templates—Displays panel templates and widgets for use in creating
windows with the Window Editor. See Creating Windows on page 87.

m  Timers—Contains an up timer and a down timer.

In the library tab, you can access window options such as create, edit, rename, and delete.
See Creating Windows on page 87 for more information.

You can also create, edit, and delete alarm templates. See Working with Alarms and
Alarm Templates on page 104.

When you search a library, all sub-libraries are searched.
Enter your search text in the search field.

If you enter Clock, all clocks will appear. If you enter 4, all items that contain the letter 4 in
their name will appear.

There are two viewing options:

T, Bl

Window_4zmil
AnalogCockd png backgroundd jpg AR

tad ok Ll rad

Window_4:ml

AnalogClockd png backgroundd jpg

Figure 7-3 Large Icons

When you click on an object in a library, that object’s properties panel opens.
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® Library Properties

Mame

Type
Creation Date
Last Modifed
Description

Custom

Figure 7-4 Library Properties Panel for a Custom Window

Table 7-1 Library Properties Panel Objects

Item Description
Name The title by which the item is labeled in all libraries
Type Can be any of the following:

= All

= Windows

m Backgrounds

m Clocks

= Alarm Templates

» Window Templates

= Timers

This designation determines the sub-libraries the item will appear

in.

Creation Date Only appears for custom library items (clocks, windows, alarms or
backgrounds). This is the day and time when the object was
Created.

Last Modified Only appears for custom library items (clocks, windows, alarms or

backgrounds). This is the day and time when the object was last
edited. If the object has never been edited, then it and the
creation date will match.

Description When the object is created, this field matches the Name field
above. To alter the description, click the Rename option for this
object type. Only custom objects can have their description
modified.

Custom = True—This object was created or imported to the system and
can be modified, deleted, etc.

m False—This is a default object on the system and cannot be
modified or deleted.
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Adding and Removing Backgrounds

You can add up to eight custom backgrounds to the library in HView Designer. When you
upgrade your system, you can choose whether to keep these backgrounds.

A suitable background meets the following specifications:

m JPG or PNG file type
m Smaller than 1024 pixels
For best results, the background image should have an aspect ratio of approximately 16:9.

Adding Graphics to the Background Library

Up to eight custom backgrounds can be added to the library. Backgrounds are stretched or
squished to fit the area of the layout when used.

On the main page, click View and Edit Library.
The library panel opens or comes to the front.

From the menu at the left of the screen, click Import a Background.

If this option is not available (greyed out) it may be because a panel is already open at the
bottom of the screen. Close that panel and Import a Background becomes available.

" Browse... | Name: background 15 Dimensions: 1024x625

Mote: It is recommended that each of the picture dimensions be less than 1024 pixels.

Please make sure the aspect ratio is close to 16/9.

Save I P cancel

Figure 7-5 Adding a Background

Click Browse and then browse to the file.

The selected file appears as a thumbnail in the right of the panel. If the file is not a suitable
size, the Save button will not enable.

Click Save.

If you already have the maximum number of custom backgrounds saved on the system, you
wil see an error message. Delete and unneeded background and then try your save again.

Deleting Graphics from the Background Library

On the main page, click View and Edit Library.
The library panel opens or comes to the front.

From the menu at the left of the screen, click Delete a Background.

You can only delete custom backgrounds that have been imported into the system, not
backgrounds that are by default on the system). If this option is not available, then the
object you are trying to delete is not a custom background.
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Creating Windows

Windows are the basic building blocks of a layout. You can create new windows and store
them in the library, edit them, and delete them.

A window is made up of a panel, which contains a series of containers for all the other
items in the window. The panel contains one video input, plus tallies, labels, and audio
meters (collectively known as widgets, when applied to a window).

Tally ‘_r . e —

Label / i i : Spacer objects
.: | | | i Video input

Audio meters Simple label

Label with

background

Figure 7-6 Window Objects
To launch the Window Editor, from the Home tab, click Create New Window.

If this option is not available (greyed out) it may be because a panel is already open at the
bottom of the screen. Close that panel and Create New Background becomes available.
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The following tab appears:

HView Designer Harris Broadcast

Home  Editor * m

Window View @ New Window 1 Hoose | | View - Edits Save To Library

Search @

© video Borders

® ranel Margins
Bottom o

Left 5

Right 5

Top =
0 Background Style
Style I"Geko

© General

LRC Source

Name New Window 1

Library "panel | View By Small

Main Panel with widgets on Main Panel with widgets on Main Panel

Main Panel ity T

Figure 7-7 Window Editing Tab

Table 7-2 Display Profile Tab Definitions

Key |Item Function
0 Window Editor tools See Using Window Editor Tools on page 89
9 Window Canvas Displays the currently selected window.
9 Window Library Contains two types of objects:

m Panels—A window template that has areas defined for video inputs and
widgets.

m Widgets—Objects that go in the defined regions of a panel, including
tallys, audio meters, labels, and spacer objects.

For more information on Libraries, see Using Libraries on page 83

a Properties panel Shows details of items in the window.
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Key

Item

Function

5]

View and Save options

Redo.

This region includes standard view menu and view scale, as well as Undo/

m Save to Layout only appears when the Window Editor has been launched
as a right-click option from a Layout.

m Save to Library will only save a window that has had changes made to it.
See Saving a Window on page 98.

(6]

Show window view /
Show selectable items

Indicates the view state defined by the top two buttons of the tool panel. See
Using Window Editor Tools on page 89.

Using Window Editor Tools

On the left side of the display, there are four buttons.

Table 7-3 Window Editor Toolbar Items

Tool

Name

Function

D

Clear outline view

Hides the container regions on the window. When
you click on the window, items display their outlines,
so the window may fill up with dotted lines over time.

Show outline view

Shows dotted lines on the window indicating the
different container regions.

Zoom in

Click the left mouse button to zoom in.

Zoom In

Left mouse button zooms out.

Library Panel in the Window Editor

You can expand or contract the Library panel by hovering the mouse over the middle of the
top of the panel until the mouse displays a double-pointed arrow. Click and drag the cursor
up or down, and then release when the panel is at the size you want.

m  Window Templates—Displays templates, that can contain windows and other
elements.

m  Widgets—Includes tallies, audio meters, and sample layouts that can be added to a
Window. This library is primarily intended for use in the Window Editor. See Working
with Widgets in a Window on page 91.

For information on using the library panel in the window editor, see Adding Widgets to a
Panel on page 91 and Changing the Panel Applied to a Window on page 89.

Changing the Panel Applied to a Window

A window starts with the default panel applied to it. To change the panel on a window,
follow these steps:
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1 Inthe Library pane at the bottom of the Window Editor, choose Panel from the drop-down
menu.

Library "panel 1 View By Small ¥ Large

Main Panel with widgets Main Panel with widget on

Main Panel v o

Figure 7-8 Panels in the Library

2 Click on a panel and drag it to the Window canvas.

When you click on a window in the Window Editor with the Modify Window View tool
selected, you can modify the panel size in the Properties pane.

3 Open the Panel Margins or Container Margins palette to adjust the distance between a
panel and any adjacent objects, such as video objects, other panels, and the outside edges
of the panel. When you change the margin sizes, the space is added or removed from the
objects within the panel, rather than from the panel itself. The margin can be as small as 0,
where the panel is butted up against objects beside it.

A panel can be sized in one direction. A panel at the top or bottom of the screen can be
scaled by width, and a panel (at the left or right of the screen)

Table 7-4 Sizing Options for a Panel

Control Options

Panel X or Y Size m Fill — After space is allocated to fixed and
dynamically-sized panels, the remaining space is
divided between all panels that are fill-sized. If there is
no space, these panels are assigned a width or height
of 0 pixels.

m Fixed — This option has the highest priority. When
selected, the Y Size % field becomes available. A Fixed
panel takes up the allocated space, diminishing the size
of other panels if required.

m Dynamic — This option has the second highest
priority. All space remaining after fixed panels are
placed is divided up equally between dynamically sized
panels.

X orY Size (Pixels) Width or Height of a fixed-size panel, measured in pixels.
The minimum size is 20 pixels, and the maximum depends
on other objects in the window.

4 Open the Container Margins palette to modify the top, bottom, left, and right margins of
the selected container.
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Working with Widgets in a Window

The Widget Library contains all the different types of objects that can be used in a window.
Widgets include:

Table 7-5 Library Widgets That Can Be Added To Windows

Object Description

Tally There are four types of tally:

m Red

m Green

= Yellow

m Blue

See Modifying a Tally in the Window Editor on page 96.

Label m Simple Label

m Label with Background — The text in this label is resized to fit
within the label margins. See Label Margins on page 98.

Audio Meter You can either have an audio meter or labels, tallys and spacer
objects within a vertical container. You cannot put an audio
meter in a horizontal container. You can put an audio meter on
either end of the video portion of a window whether there is a
panel spot for it or not. This means if the panel has two vertical
containers, the window can potentially hold four audio meters.
See Modifying Audio Meters in Window Editor on page 94.

Spacer Object Creates an empty spot in the container. See Modifying a
Spacer Object in the Window Editor on page 95.

Adding Widgets to a Panel

You can add a widget to any region of the window except the video container. Some panels
have a container that overlaps the video container, and widgets can be added to that.

Click a widget in the library at the bottom of the screen and drag it to the Window canvas.

2 When an area becomes outlined in yellow, drop the widget and it is added to that area of
the screen.

Widgets are added to the right end of horizontal containers, and below the previous widget
in vertical containers.

Deleting a Widget from a Window

1 Click on the widget with the mouse.
2 Open the Properties panel for the widget.

If the widget is a Tally widget, you would open the Tally Properties panel. If it is a label, you
would open the Label Properties panel.

3 Click Delete Item.

The item is removed from the container, and the other items in the container are shifted to
fill the space.
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Modifying Relative Widget Positions

Click a widget in the Window.
The container the widget is in must have within it at least two widgets.

Click the Move Left and Move Right buttons.

The widget moves one position in the selected direction, displacing other objects within
that container.

Modifying Widget Sizes

Widgets can be sized independently. Follow these steps:

Click a widget in the Window.
Open the Sizing Options palette in the Properties Panel.

0 Sizing Options

| -
Widget ¥ Size Dymamic

Y Size %
==
Panel X Size Fixed

¥ Size(Pixels)

Figure 7-9 Widget Sizing Options

A widget can be sized in one direction. Widgets in a wide panel for example at the top or
bottom of the screen can be scaled by width only, and widgets in a tall panel (at the left or
right of the video pane) can be scaled by height only. The other dimension is defined by the
panel size.

Table 7-6 \Widget Properties Panel Options

Sizing Option Description

Widget X or Y Size m Fill — After space is allocated to fixed and
dynamically-sized widgets, the remaining space is
divided between all widgets that are fill-sized. If there
is no space, these widgets are assigned a height or
width of 0 pixels.

m Fixed — This option has the highest priority. When
selected, the X or Y Size % field becomes available. A
Fixed widget takes up the allocated space, diminishing
the size of other widgets if required.

m Dynamic — This option has the second highest priority.
All space remaining after fixed widgets are placed is
divided up equally between dynamically sized widgets.

XorY Size % Width or height of a fixed-size widget, measured in pixels.
The minimum Y size is 20 pixels

The minimum X size is 10 pixels

The maximum depends on other objects in the window
and the size of the window itself.
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Modifying Object Properties
Each object in a window can be modified in the Window Editor. If you need to modify a
window object later, the window can be reopened in Window Editor from its position in a
layout. the changes can be applied to that window only or to all instances of the window in
the layout.

Modifying the Video Portion of a Window

Some of the items in the Video portion of a window can be further modified when the
window is added to a layout.

Table 7-7 Video Properties Options for a Window

Item Function

Video Borders ' _ _ _ ' . '
This control can be overridden on a window-by-window basis when the window is used in

a layout. See Editing Video Properties on page 68

Enable Activates borders on the video portion of the window.

Size Range —1 to 10 (default 2)

Panel Margins

Bottom Defines the shape of the video window. Each dimension
has a minimum value of 0, The maximum varies

Left depending on the settings for the other margins and the
Right overall size of the video.
Top

Background Style

Style m None—The spaces between containers show through
to the background of the layout.

m Crisp—Spaces between containers have lines.
m Geko—Spaces between containers are solid.

General

Name This is the name the panel will be saved with.
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Modifying Audio Meters in Window Editor

Table 7-8 Audio Meter Properties Options for a Window

Item Function

Audio Object

Delete Item Removes the object from the window

Container Margins

Bottom Defines the shape of the video window. Each dimension has
Left a minimum value of 0, The maximum varies depending on
the settings for the other margins and the overall size of the
Right video.
Top
Audio
Channels By default, Embedded Audio channels 1 - 4 are listed.
s Add Embedded: Adds the next available embedded
channel.

m Add Discrete: Adds the next available TDM channel.
Note: TDM is not currently supported.

Neither add button will add a channel that is already
selected on the window, whether in this audio meter or any
other audio meter that might be associated with the
window.

To change the channel, click the channel’s label and all
channels of that type are displayed (either embedded or
TDM).

Up/Down: Moves the audio channel up or down one level
in the list.

Del: Deletes the channel.

Show Graticule When checked, audio meter scale indicators are displayed.

Background Style

Style m None—The spaces between containers show through to
the background of the layout.

m Crisp—Spaces between containers have lines.
m Geko—Spaces between containers are solid.

General

Name This is the name the panel will be saved with.

When the window is added to a layout, channels can be added and removed on individual
windows. However, the Show Graticule setting can only be configured by reopening the
window in the Window Editor.
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Modifying a Spacer Object in the Window Editor

Spacer objects allow you to separate objects within a container.

Table 7-9 Spacer Object Properties Options

Control Function
Spacer Object
Delete Item Click to remove the object from the window.

Sizing Options

Widget X or Y Size

m Fill — After space is allocated to fixed and
dynamically-sized widgets, the remaining space is
divided between all widgets that are fill-sized. If there is
no space, these widgets are assigned a height or width
of O pixels.

m Fixed — This option has the highest priority. When
selected, the X or Y Size % field becomes available. A
Fixed widget takes up the allocated space, diminishing
the size of other widgets if required.

m Dynamic — This option has the second highest priority.
All space remaining after fixed widgets are placed is
divided up equally between dynamically sized widgets.

XorY Size %

Width or height of a fixed-size widget, measured in pixels.
The minimum Y size is 20 pixels

The minimum X size is 10 pixels

The maximum depends on other objects in the window
and the size of the window itself.

Panel Margins

Bottom

Left

Right

Top

Defines the shape of the video window. Each dimension
has a minimum value of 0, The maximum varies
depending on the settings for the other margins and the
overall size of the video.

Positioning

See Modifying Relative Widget Positions on page 92.

Background Style

Style m None—The spaces between containers show through
to the background of the layout.
m Crisp—Spaces between containers have lines.
m Geko—Spaces between containers are solid.
General
Name This is the name the panel will be saved with.
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Modifying a Tally in the Window Editor

Tallys can only be modified in the Window Editor.

Table 7-10 Tally Properties Options for a Window

Control Function
Tally
Tally ID Choose a number from the menu:
m Red defaults to 1
m Green defaults to 2
m Blue defaults to 3
m Yellow defaults to 4
m Nothing defaults to 5, but it is available
Delete Item Click to remove the object from the window.

Sizing Options

Widget X or Y Size

m Fill — After space is allocated to fixed and
dynamically-sized widgets, the remaining space is
divided between all widgets that are fill-sized. If there is
no space, these widgets are assigned a height or width
of 0 pixels.

m Fixed — This option has the highest priority. When
selected, the X or Y Size % field becomes available. A
Fixed widget takes up the allocated space, diminishing
the size of other widgets if required.

m Dynamic — This option has the second highest priority.
All space remaining after fixed widgets are placed is
divided up equally between dynamically sized widgets.

XorY Size %

Width or height of a fixed-size widget, measured in pixels.
The minimum Y size is 20 pixels

The minimum X size is 10 pixels

The maximum depends on other objects in the window
and the size of the window itself.

Container Margins

Bottom

Left

Right

Top

Defines the shape of the video window. Each dimension
has a minimum value of 0, The maximum varies
depending on the settings for the other margins and the
overall size of the video.

Background Style

Style m None—The spaces between containers show through
to the background of the layout.
m Crisp—Spaces between containers have lines.
m Geko—Spaces between containers are solid.
General
Name This is the name the panel will be saved with.
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Modifying a Label in the Window Editor

Aspects of a label, such as the text of the Fixed field, can only be modified when the
window is used in a layout. There are two types of label that can be added to a window:
simple labels and labels with background. The controls are the same, except that the label
with background has additional background controls, as noted in Table 7-11.

Table 7-11 Label Properties Options for a Window

Control

Function

Label

Label Source

Fixed—Label displays the contents of the Text field.

UMD—Label displays data provided from either the
routing database or an external UMD protocol,
associated with the parent window’s ID, and further
specified by the UMD Source parameter.

Video Standard—Label displays the video standard of
the video input source.

Aspect Ratio—Label displays the aspect ratio of the
video component of the window.

Program ID—Label displays ID information contained
in the video stream’s metadata.

VChip—Displays the V-Chip rating that is contained in
the video stream’s metadata.

Closed Caption—Label indicates the presence or
absence of CC 608 and CC 708 captions.

Automation—Displays information provided by an
A8100 D-series automation system. See Configuring
A8100 D-Series Automation on page 154.

Teletext—Displays Closed Caption or other metadata
information. See Table 6-13 on page 68.

UMD source

When the Label Source is set to UMD, this option helps
define the label contents:

Primary—Displays primary UMD from the external
UMD protocol

Secondary—Displays the secondary UMD from the
external UMD protocol that supports secondary UMDs.

LRC Source—Displays the source UMD from the
Logical Router database.

LRC Destination—Displays the destination UMD from
the Logical router database

Text color

Click to open a palette, from which you can select a
shade, measured in RGBA.

Text background

Click to open a palette, from which you can select a
shade, measured in RGBA

Font Click to choose from a menu:
= Arial
m Verdana
Delete Item Click to remove the label object from the window.
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Table 7-11 Label Properties Options for a Window (Continued)

Control

Function

Label Margins

These settings apply to Label with Background only. See Modifying a Label in the
Window Editor on page 97 for more information.

Bottom

Left

Right

Top

Determine how far from the edges the text can fit. The
text is resized to fit within these margins.

Sizing Options

Widget X or Y Size

m Fill — After space is allocated to fixed and
dynamically-sized widgets, the remaining space is
divided between all widgets that are fill-sized. If there is
no space, these widgets are assigned a height or width
of 0 pixels.

m Fixed — This option has the highest priority. When
selected, the X or Y Size % field becomes available. A
Fixed widget takes up the allocated space, diminishing
the size of other widgets if required.

m Dynamic — This option has the second highest
priority. All space remaining after fixed widgets are
placed is divided up equally between dynamically sized
widgets.

XorY Size %

Width or height of a fixed-size widget, measured in pixels.
The minimum Y size is 20 pixels

The minimum X size is 10 pixels

The maximum depends on other objects in the window
and the size of the window itself.

Container Margins

Bottom

Left

Right

Top

Defines the shape of the video window. Each dimension
has a minimum value of 0, The maximum varies
depending on the settings for the other margins and the
overall size of the video.

Background Style

Style m None—The spaces between containers show through
to the background of the layout.
m Crisp—Spaces between containers have lines.
m Geko—Spaces between containers are solid.
General
Name This is the name the panel will be saved with.

Saving a Window

If the window editor was opened from the Library, you will have a Save to Library button.
If the window was opened from a layout (using the Edit Window Style right-click option in
the layout) you will have an additional button in your window Editor.
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(Optional) In the Properties panel, open the General tool, and then, beside Name, enter a
descriptive name for the window.

Click one of the following:
m  Save to Library—The window is added to the library tab.
If the window has been previously saved, there are two options:

o Update the existing window style in the library. Saved style name: —This
option overwrites the window.

o Save as a new window style in the library. Saved Style name:—This option
saves the window with a new name that you enter in the Saved style name field,
while leaving the pre-existing window intact.

m  Save to Layout—This option only appears if the Window was opened from a Layout
(see Right Click Options with the Pip Window Selection Tool on page 63). The
following options appear:

o Apply the changes to the edited window in layout only

o Apply the changes to all windows that have the same style as the edited window in
layout

Neither of these options saves the window to the library.
Make a selection and click OK to proceed.

Renaming a Window

Once a window has been created you can rename it from the library tab.

If the Window editor is open, close it.

You cannot launch a window into the Window editor when it or another window is already
open for editing.

Select the window in the Library tab.
Click Rename a Window.
This task cannot be done when the Window Editor is open.

A region opens at the bottom of the display:

New Custom Name: TopManyTallys

New Description:

Cancel

Figure 7-10 Renaming a Window

Enter a new name.
You can also enter a description, but this is optional.

Click Save.
The Library is updated with the new window name.

Deleting a Window

Once a window has been created you can delete it from the library tab.

If the Window editor is open, close it.
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You cannot delete a window when it or another window is open for editing.

Select the window in the Library tab.
Click Delete a Window.
This task cannot be done when the Window Editor is open.

Click Yes to confirm the deletion.

The selected window is removed permanently from the library.

Reopening a Window or Textbox for Modification

Windows, textboxes, and automation textboxes can all be opened for editing.

Opening a Window or Textbox From the Library

If the Window editor is open, close it.

You cannot launch a window or textbox into the Window editor when it or another
window is open for editing.

In the Window library, click the window or textbox to reopen.
Click Edit a Window.
This task cannot be done when the Window Editor is open.

The Window Editor launches, populated by the selected window or textbox .

Opening a Window or Textbox From a Layout

You can also open a window or textbox for editing from the Layout Editor.

Right-click on a window or textbox and select Edit Window Style.

If a window is already open in the Window editor, focus switches to the window editor with

the already open window. Otherwise, focus switches to the window editor with the
window selected in the layout.

The selected window or textbox in the Layout editor tab turns yellow and indicates that it is
open for editing. No modifications can be made to the layout until the window is closed in

the window editor.

Make modifications to your window or textbox.
Save your window or textbox as described in Saving a Window on page 98.

If you want to save the window or textbox to the library and the layout, you must perform

the save operation once to each place.
Close the window editor.

You can now edit the layout in the Layout editor again.
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Editing You can edit a digital clock or an automation clock in the window editor.

Clocks

Edit a Clock To edit a digital clock, follow these steps:

1 If the Window Editor is open, close it by clicking the X in its title tab.

You cannot launch a clock into the Window editor when the Window editor is already
open.

2 On the Home tab, click View and Edit Library if the Library tab is not already open.
3 At the top of the Library tab, open the Library menu and choose Clocks.
The Library tab refreshes to show only the clocks.

4 Click one of the following:
m  Digital Clock
m  Automation Clock

m A clock that has already been made (will also be a digital clock but will have a different
name)

5 In the Clock Library menu, choose Edit a Clock.

HView Designer

==, Home Editor x m

| Library Library  [Clocks ' ; View By © Small ® Large

# Import a Background

||

w Library

% Create a New Window Digital Clock Automation Clock

Library =)
= Analog Oock 3

# Edit a Clock
#* Rename a Clock

% Delete a Clock
Alarm Library

* Add New Alarm Template

Figure 7-11 Clock Library With a Custom Clock Selected
The Window Editor tab opens with the selected clock open for editing.

6 Click the clock to open the Clock Properties at the right of the screen, and make changes to
the clock.
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Renaming a
Clock

Table 7-12 Custom Clock Options

Control

Options

Background Style

Style

m None—The clock background is transparent and shows
the Layout background behind the numbers.

m Crisp—Places a soft-edged box around a black
background behind the clock numbers.

m Geko—Places a hard-edged box around a black
background behind the clock numbers.

m Clock—Places scrolls at the left and right of the
numbers and edges around the black background
behind clock numbers.

m Outline—Places a thicker outline around a black
background behind the clock numbers.

Settings

Digit color

Click the button to open a color picker window. When
you've used the available tools to get the color you want,
click OK to close the window.

Font

= Arial

m Verdana (note: this font does not appear on the
monitor)

Clock Margins

Bottom Positions the clock within the box, with higher numbers
positioning it closer to the top of the box, and making the
numbers smaller.

Left Higher numbers move the number to the right.

Right Crops the right edge of the number.

Top Positions the number lower in the box.

General

Name Enter a descriptor by which the clock will be labeled in the

library.

Click Save to Library.
Close the Window Editor.

Your clock appears in the Clock Library and can be added to layouts.

You can only delete custom-made clocks.

If the Window tab is open, close it.
You cannot rename a clock with the Window tab open.

Click the clock you want to rename, either in the Clock library, or in the general library.
Under Clock Library at the left of the screen, select Rename a Clock.
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A box appears at the bottom of the screen.

Mew Custom Mame: small and Blue

Mew Description: Right-cropped. |

Save | Cancel

Figure 7-12 Renaming a Clock

4 Enter a new name for the clock.
5 (Optional) Enter a new description for the clock.
6 Click Save to update the clock’s properties panel.

() Library Properties
MName

Type

Creation Date

Last Modifed

Description

Custom

Figure 7-13 Library Properties for a Clock

By default, the clock’s description is the same as its name. The only way to change its
description is in the clock editing pane.

Deleting a  The Delete option is only available when a clock is custom-made.

Clock

1 If the Window tab is open, close it.
You cannot delete a clock with the Window tab open.

2 Click the clock you want to delete, either in the Clock library, or in the general library.
3 Under Clock Library at the left of the screen, select Delete a Clock.
A dialog box asks if you are sure you want to delete the clock.

4 Click Yes.
The clock is removed from the general and Clock libraries.
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Working with Alarms and Alarm Templates

Alarm templates are a quick way to assign the same alarm settings to numerous windows,
or to save the same settings to different layouts. In the Alarm library, you can create, edit,
and delete alarm templates.

When an alarm template is active, you have to save or cancel to look at a different library.

Creating an Alarm Template
1 If the Window tab is open, close it.
You cannot create an alarm template with the Window tab open.

2 At the left side of the Library tab, click Add New Alarm Template.

An Alarm Template panel opens at the bottom of the screen, and the Properties panel at
the right of the screen updates to display alarm options.

HView Designer Harris Broadcast

— L

Library n -
Al -

D Alarm T Alarm
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options

Alarm Template -1
[ELTE

O Audio Alsrm

Figure 7-14 Alarm Template at Bottom of Library
The parameter palette opens at the right of the screen.

3 At the bottom of the screen, enter a Template Name.

The Description field fills in at the same time. You can enter a different description, but it's
not required.

4 Select video alarms and audio alarms, and video and audio alarm actions.
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Click Save.
Your new alarm template is saved to the library.

Editing an Alarm Template

1

If the Window tab is open, close it.
You cannot create an alarm template with the Window tab open.

Click on an alarm template in the library.
Click Edit Alarm Template.

The Alarm Template tools open at the bottom of the screen. The Alarm Palette opens at the
right of the screen.

Make any changes to your alarm template.

If you change the template’s name, a new template is saved, rather than overwriting the
alarm template that you opened.

Click Save.
Your new alarm template is saved to the library.

You can also click Cancel to return the alarm template to its original settings.

Deleting an Alarm Template

1

2
3

If the Window tab is open, close it.
You cannot create an alarm template with the Window tab open.

Click on an alarm template in the library.
Click Delete Alarm Template.
The alarm template is removed from the library.
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8 Live Operation

Controlling HView SX Pro Live
Live control of HView SX Pro is best executed using the HView Designer. Many on-air
controls for HView SX Pro appear on the HView Designer Home tab.

HView Designer Haeris Broadoast

@ Change Aodie Livme

W Cicaly Hew Wedim
W Viorw el Ed Ly

Input 23 Input 24

Input 25 Input 26

Shaw Full Soreen

Figure 8-1 HView Designer Workspace

Live control elements are described below:

Edit Active Layout-Opens the layout on the layout canvas in an Editor tab.
There, you can edit the layout and save it to the output display using Save as
Active. See Working With Layouts on page 49.

Change Active Layout- Opens a dialog box where you can look at all
layouts, select one and then send it to the display. See Using the Change
Active Layout Dialog Box on page 108.
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Display Profiles - There will be three or six displays, depending on whether
you have a HView SX Pro-16, -32, Or -64. Click a display to see the layout on
that display in the Layout Canvas. Each display has a bit of descriptive
information.

Change Display Profiles- A display profile defines the monitors that are
configured.

Layout canvas - Displays the current active layout on the chosen display
device. If no display device is selected, or no layout exists on that device, or
the device is not currently available, no active layout will appear.

Control Panel - This panel can be hidden or expanded and displays options
for the selected element in the layout canvas. See Using the Control Panel
on page 109.

Mouse Control - When enabled, a mouse appears on the output monitors.
Depending where you click, different options will appear. See Using Mouse
Control on page 111.

© © & O

Using the Change Active Layout Dialog Box

Indicates the
active preset

A yellow border
indicates the
selected layout

Toggles Full view
and Group view

You can look at all available layouts in the Change Active Layout dialog box before choosing
one to send to the selected display.

On the HView Designer Home tab, click Change Active Layout.
The Change Active Layout dialog box opens.

Thaspd At vt

Input 3 Input 4 Input 7 Input 8

Duplicate 1 Duplicate 2

Duplicate 3 Duplicate 4

Figure 8-2 Change Active Layout Dialog Box

Select a preset from the list on the left.
The display at the center of the screen updates to show the layouts involved in that preset.

Click a layout and then click Set Full View to see that layout in full-screen. Click Revert to
Group View to see all layouts (there will be three layouts with HView SX Pro-16 and HView
SX Pro-8x3-28 modules).
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3 Click Set Preset Active to assign the preset to the displays.

Using the Control Panel

The control panel at the bottom of the Home screen allows you to control live elements of
the layout while it displays on a device.

When a control is enabled, the background of that button changes to a light color blue to
indicate its enabled state.

To expand the control panel, click the button at left of the Control panel bar at the bottom
of the screen. To hide the control panel, click the button in its top left corner.

When you click on a window in the active layout, the control panel updates to provide
control options for the video and audio assigned to that window.

Expand/Hide Control Panel

= Control Panval  <Window 2>

Show Tull Screen

Cheres Pair

Raating

Figure 8-3 Control Panel

Table 8-1 Control Panel Options For a Window

Item Function

Search Source As you enter text in this field, the source list updates to
display only items that contain the search text. To return
to the full list, click the X at the right edge of the field.

Video Source Select The drop-down menu lists all the sources. Choose one
and then click Take to change the source of the video
input.

Click Show Routing / Show Video Input (the button
label toggles) to view the different naming convention
labels on the video inputs.

Show/Revert Full Screen Sets the currently selected video input to display across
the whole screen. The image is not rescaled, so if it is a
different aspect ratio than the output display, the overlay
will not be complete, and the image will be centered,
with the layout still showing in the background.

When the selected window is displayed full-screen, the
Show/Revert Full Screen button turns blue.

To return to the normal layout display, click the button
again. The button turns gray.
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Table 8-1 Control Panel Options For a Window (Continued)

Item

Function

Output Audio

Activates the audio output for the video input. The audio
type is determined by the Audio Type menu.

If another video input is playing this audio type and you
select this button, the other audio stops and this audio
plays instead.

If AES and HDMI audio are muted then both are
reactivated when this button is clicked.

Mute Audio

Mutes audio monitoring output (from both AES and
HDMI, if both are activated). Use the Output Audio
button to un-mute.

Monitor Disable

Disables the selected (AES or HDMI) audio monitoring and
removed the connection to this Pip. Use the Output
Audio button to re-enable.

Discrete

Activates or deactivates TDM audio. Note: TDM is not
currently supported.

Audio type menu

Choose the output interface for the audio output monitor
m AES

s HDMI

Stereo Pair Choose the audio pair to output on the audio output
monitor.

Volume Adjust the audio volume on the output of the audio

monitor.

Input 19

Indicates audio monitor is
enabled on this window

LRC Source

Audio monitor is muted

Label can indicate the
following states:

m AES

Input 22 " oot

LRC Source

Figure 8-4 Monitoring Full-Screen and Indicating Muted Audio
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When you click on a timer in a layout, the control panel updates to provide options for that
timer.

Expand/Hide Control Panel

¥ Control Panel  <Window 8>

Mouse Control

Figure 8-5 Control Panel

Table 8-2 Control Panel Options For a Timer

Item Function

Start Starts the timer

Pause Pauses the timer

Reset Resets the timer to its preconfigured starting value.

Using Mouse Control

Even when no video window is selected, Mouse Control is available.

Table 8-3 General Controls

Item Function

Mouse Control Activates remote mouse control.

When mouse control is enabled, the Control panel minimizes itself. To deactivate mouse
control, press SHIFT+F8 to exit.

The mouse now appears on the output monitors. Depending where you click, different
options will appear.
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Video Window

Click a video window to see the following options:

Table 8-4 Video Window Options

Menu Option When Selected

Router source A menu of all available sources appears. Choose a source
and click OK to apply that source to the video window,
or Cancel to close the window leaving the source as
previously selected.

Follow Destination Menu of all available destinations

FullScreen/Unfullscreen Toggles the selected video window as full screen or
reverts to the layout

Route Audio On the box that opens, select an Audio Output
Channel from the menu on the left, and then select an
Audio Channel Pair from the menu on the right.
Set—Routes the selected output channel and audio pair
but does not apply the change

Apply—Routes all the selected channel pairs that you set
to the corresponding audio output channels and closes
the panel

Close—closes the Route Audio panel

Note: When you are viewing the layout live on the output, A video window that shows
green on the monitor has a scalar assigned that is outside the display group.

Il

Background

Click on an area of background to see a single item, Recall Layout. When you select this
option, a list of presets appears. Select a preset and click OK to apply that preset, or Close
to cancel.

A message appears on the screen indicating that the layout has been changed.

Timer

Click on a timer that is not running. There are two options:

m  Start— Click to activate the timer, and the Start option becomes Pause. When the
timer is in a paused state, that option becomes Resume.

m  Reset—Click and the timer goes back to its original time.



Table 8-5 Timer Status Indicators
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Timer Indicator

Name

Description

End Time Counter

The timer has reached its end time.

Pause Counter

The Timer is paused.

Play Counter

The counter has been started and is
currently counting up or down.
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O Diagnostics

Using Diagnostics
1 From the HView Designer Home tab, select View Diagnostics.
A dialog box opens, displaying any errors.

Diagnostics

_—
z The system is running with no errors recorded.

Figure 9-1 Diagnostics Dialog Box

Installing Magellan Diagnostic Logging

Magellan Diagnostic Logging is purchased separately. It is installed on a PC on the same
network as the HView SX Pro, and receives messages designated by the system
administrator for review.

System Requirements

Hardware Requirements

Magellan Diagnostic Logging can be installed on a PC that meets or exceeds the following
requirements:

m 3 GHz Pentium IV processor (Core 2 Duo - 2.39 GHz recommended)
m 1 GB RAM (2 GB recommended)

m  100-BaseT Network connection

= Minimum 20 GB HDD drive

m 1 GB Available Disk Space

= DVD-ROM Optical Drive

m  Super VGA supporting 1152 x 864 (19-inch recommended) Display

115
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Operating System

Choose one of the following:

m  Windows 7 32-bit
m  Windows 7 64-bit
m  Windows Server 2008 R2 64-bit

Required Software

The following software must be installed prior to installing Magellan Diagnostic Logging:

m  Microsoft .NET 4 Client Profile

m  Microsoft .NET 4 Extended

m  Microsoft .NET Framework 3.5.1 Feature (Microsoft Windows Server 2008 r2 only)
m  Microsoft Silverlight 5.1 or higher

m  Microsoft Visual C++ 2010 x64 Redistributable for Windows 7 64bit

Installing Magellan Diagnostic Logging

Double-click the correct file, depending on your operating system:

m  MagellanDiagnosticLogging32-BitNetworkServerandClientRuntime xx.xx.xx.msi
m  MagellanDiagnosticLogging64-BitNetworkServerandClientRuntime xx.xx.xx.msi

Magellan Diagnostic Logging uses InstallShield. Follow the instructions that appear on the
screen. It is not necessary to reboot the PC after installing the software.

Configuring HView SX Pro for Magellan Diagnostic Logging
In HView Designer, on the Home tab, click HVD Logging Enable: OFF.

The button label changes to show HVD Logging Enable: ON.

Launching Magellan Diagnostic Logging

To launch Magellan Diagnostic Logging, do one of the following:

m  From the Start menu, select All Programs > Harris > Magellan Diagnostic Logging
> Diagnostic Logging Viewer.

= Inthe URL field of your browser, type http:/localhost:8002/
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The home page of Magellan Diagnostic Logging lists all devices configured to send
messages to the server.

Magellan™ Diagnostic Logging

m Live Logs:All * Live Logs:All * |

Application Profiles * Examine Logs | | View Live Logs | | Show Filters/Actions il
Device Name / Application / Module
™ 5D012669 " Export
™ HView Designer

" LayoutCreatorSL History

~ Import and Yiew Log Collections
Log Collections % f Import Logs Collection Devices Examine Logs |

Collection Name Date/Time Collected Comments Device Name / Application / Module

Figure 9-2 Home Page of Magellan Diagnostic Logging

Diagnostic Logging’s Home tab displays a list of devices that send it messages. The device in
Figure 9-2 has received log messages from one device.

The PC hosting HView Designer has a sub-device that you can view by clicking the down
arrow. Below the sub-device is the log. To view a summary of the log for a device, click
History at the lowest level of the log entry.

Magellan™ Diagnostic Logging

Home @ Live Logs:All x W;MT0T.H

Device: SD012669-HView_Designer-LayoutCreatorSL 3 Export Examine Logs

Total Mes

2 Error, 51 Informational 53

Figure 9-3 History for an HView SX Pro Device
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Diagnostic Logging Interface

Magellan™ Diagnostic Logging =) : ttings - | Al HARRIS

Examine Logs | | View Live Logs  Show Filters/Actions +fl

= Import and View Log Collections
Log Collections x 'ImportLogs | Collection Devices Examine Logs |

De cation / Module

Figure 9-4 Diagnostic Logging Home tab

Table 9-1 Diagnostic Logging Interface Options

Item Description

0 Home Tab The Diagnostic Logging Home Tab.

9 Device The available elements to view logs for

6 History Select an element and click the History button to view
History for the selected element

a Examine Logs Select an element and click the Examine Logs button
to review logs for the selected element

6 View Live Logs Select an element and click the View Live Logs button
to view real time logs for the selected element

@ Filters and Actions Click to filter display and content preferences for logs

0 Export Select an element and click the Export button to export
log information. Logs can be exported by day, week, or
all.

@ Summary Click the Summary icon to display a Summary toolbar

at the top of the page that contains shortcut links to
Exports, Imports, and Collections. See Using
Summaries on page 124.
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Table 9-1 Diagnostic Logging Interface Options (Continued)

Item

Description

@ Import and View Log
Collections

Click to view/access Log collections based on name/
date/comments - these can then be examined or
exported. You can also import logs.

@ Settings

Click to view/define System-wide settings, Log
Viewer Settings, and Logging Server Settings.

@ Find

Searches for the entered text on the page

ViEWil’lg To view a log, place a check beside the device on the Home page, and then click View Live

Logs.

Logs
Magellan™ Diagnostic Logging

Home

Live Devices/Processes: All devices

rmational

rmational T

irmational

rmational T

Figure 9-5 Live Logs for HView SX Pro System

["Refresh List | ["Examine Log

imcation: v

If no logs are selected or all logs are selected, click View Live Logs and the log that opens
will contain entries for all connected devices.

If no device has activity when you select View Live Logs, the viewer tab is empty. The viewer
updates dynamically as events occur.

Examine  On the Home tab, select devices (if no devices are selected, it's the same as if all of them
Logs are) and click Examine Logs to view logs in detail.
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Magellan™ Diagnostic Logging = HARRIS

Show a Range of I'-.-!irtl*as -

5:00:00 PM 6:00:00 PM

o
° Refresh Logs - Keep Current View
Refresh Logs - Show Latest <_°

Export Logs in Range
L ' e
04/19/2013 - 1:44:37 PM 6:44:37 PM

£:00:01

> Show Options +fl

3 4
00 ©

- 100 of 103

armational Rg

Figure 9-6 Examining a Log

Table 9-2 Examiner Tab

Item Description
1 Log Date Date to view logs from. Type in a date or click the calendar icon and go to a date.
2 Units in View Number of defined units for the log (hours, minutes, etc)
3 Display Units Units to view log information in (Days, Hours, Minutes, Seconds, Milliseconds)
4 Log Start Range The Start Point of the Log Range. Click and drag to define.
5 Log End Range The End Point of the Log Range
6 Log Range Options | Right click to view options for the selected log range. You can choose to refresh
logs or export the selected range.
7 Next Page Click to go to the next or previous page.
8 Last Page Click to go to the last or first page.
9 Options Click to view/define Log Options and to filter logs.

The top portion of the Examiner tab shows a timeline. A green marker indicates the
beginning of the viewing area, and a red marker indicates the end.

To View a specific time, click the timeline with the mouse. The log examiner updates to
show logs surrounding that time. A black line appears in the timeline, indicating the current
time in the Examiner.

Above the timeline, you can adjust the content that is displayed by changing the date and
duration. To view a different part of the log, drag the green and red sliders.
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Below the timeline, messages are displayed in a static format. You can sort the log entries
by clicking on column headers.

Changing the Content Displayed in the Examiner

In addition to sorting a log file by the display columns, you can choose to view only certain
types of logs. Follow these steps:

1 Click Show Options.
The View Options palette appears at the right side of the screen.

View Logs From 12:00 AM on

M

| showing 1 - Hide Options B+ View
Logs Per Page 100

v Expand Graph Control
ormational

Informational
ormational

national

Refresh | Logs in Examiner

nfermational
nformational Jotifica = Filters

national a ) 1D: 7' Emergency
national -
Alert
ormational
) f Critical
ormational
national g Errar
national Rei \ Ca windo sresetlD: 0, sou " Warning
nformational 7 Motice
nformational S .
Informational
national
= " Debut
formational 9
ormational otifica Filters to Examiner

ormational Ro ng Naotification: win 26, presetlD: 0, sourcel
! Actions

Figure 9-7 Show Options while Examining a Log

2 At the top of the palette, select how many logs to view, and how they will be displayed.
3 Place checks beside types of information you would like to see in the Examiner.

You can only filter out information that is being sent already from the HView SX Pro.
Settings, configured using the HView Designer supersede settings on this screen.

4 Click Apply.
The table refreshes to display the selected information.
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Export Logs When you export a log, it is saved as a zip file that can be viewed by any log viewer.

1 Do one of the following:
m  From the Diagnostic Logging Home page, do either of the following:

o At the right end of the HView SX Pro’s header line, click Export, and then choose
Past Day, Past Week, or All Logs.

o Place checks beside items in the Devices and Application Profiles list, and then click
Show Filters/Actions, and then click Export under Actions. Choose Past Day,
Past Week, or All Logs.

All selected logs (any log with a check beside it) are exported.

m  From the Examiner, click Show options, and then, under Actions, click Export.
Choose Logs in View, Past Day, Past Week, or All Logs.

m  From the History tab, place a check beside the logs you want to export, and then click
Export.

When the log is collated and ready to be saved locally, a dialog may appear, asking what to
do with the file.

2 C(lick Save to save the file to the local computer. You can choose a different location for the
file.

If this dialog does not appear, but a progress bar appears instead, the file is being
transferred to the local computer.

When the export has finished, a message appears on the top left corner of the Diagnostic
Logging interface.

Import Logs Magellan Diagnostic Logging can import logs that it or another device has saved. To import
a log, follow these steps:

1 Click Import and View Collections at the bottom of the Home page.
The lower section of the screen expands to display something similar to Figure 9-8:

~ Import and View Log Collections

Log Collections x | Examine Collection | | Import Logs 1 Export Collection | Collection Devices I"EBxamine Logs |

Comments e 1e / Application / Module

M Exported from SDO12669 at 2013-04-19 16:59 " Delete

Figure 9-8 Import and View Collections -- Opened

2 Click Import Logs and then browse to a .zip file and click Open.

A progress bar appears, and when the import is finished, an Import Complete message
appears in the top right corner of the screen.

3 Click an item in the Log Collections column on the left.
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The Collection Devices column updates to display all devices contained in that collection.
Within each device are nested folders for each sub-device. HView SX Pro devices normally
have one sub-device.

Place a check beside each device log you would like to load in the examiner, and then click
Examine Logs.

The logs open in the Examiner. For more information, see Examine Logs on page 119.

A collection is a group of logs that you group yourself.

On the Home tab, click Show Filters/Actions.
The Filters/Actions panel opens.

Click Actions > Collect logs to network.

The following dialog box opens:

Collection
Contents:

Collection Name:

Comments:

Select Timeframe: ' Past Day

Collect Logs.. * Immediately Begin Collection

Figure 9-9 Collecting Logs to Network

Enter a name for the collection, and any comments that might help identify the purpose of
the collection or its contents later.

Select a time frame, and choose whether to collect logs immediately, or begin collection at
some later point.

Click Collect to activate the collection.
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Using
Summaries

If you have recently imported or exported a log, the Summary bar appears below the
button bar at the top of your Diagnostic Logging screen. If the Summary bar is not open,
click Summary to open it.

Figure 9-10 Summary Button
The Summary bar has three options: Exports, Imports, and Collections.
Click one of these options to open the Summary Details dialog box.

The three options correspond to three tabs on the Summary Details dialog box.
Summary Details

Exports Imporis Collections

SCO70877-2012-09-10-15-29-05-345-Log.zip

§77-2012-09-10-16-43-35-420-Log.zip

070877-2012-09-10-16-45-46-416-Log.zip

Figure 9-11 Summary Details Dialog Box

Each tab details recent activity for that area of the interface.

Clearing the Diagnostic Log

When you clear logs from the Log, all devices are also removed. Be sure to save logs that
you need prior to clearing.

If the Filters palette is not open at the right side of the screen, click Show Filters/Actions.
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2 Click Clear All Logs and then click OK.
All logs and all information in the logs are removed.

When a device has activity, it will reappear on Magellan Diagnostic Logging’s Home page.

Configuring Magellan Diagnostic Logging

Click Settings in the top right corner of the screen to open the Settings pane.

For the most part, don’t change port numbers and other settings except on the advice of
Customer Service.

Some settings that can customize system performance include:

= Minimum Log Interval
m  Columns and column order

If you are not receiving any messages, despite having devices configured, check Receive
Messages over SysLog. If this item is not checked, no messages will be received.

When you make any changes to your settings, click Save to commit the changes.

Changing Columns That Appear in Magellan Diagnostic Logging

1 On the Settings panel, scroll down to Column References.

Column Preferences: Available Visible
Enterprise ID Time
Domain ID Application
Command Line Module
Process ID Level
UTC Start Date Message
UTC Start Time
Start Date
Start Time
Host Name
IP Address

Device Name

System Sequence #

Figure 9-12 Column References Selector in Magellan Diagnostic Logging

The items in the list on the left are not currently used in the Log display. Items in the list on
the right are column headers in the Log display.

To move items from one column to the other, click on the item and hold the mouse down

while dragging from one column to the other. When you see a shadow of the item in the

column you're dragging to, release the mouse button. The item appears at the point in the
list where you dropped it.

You can change column order by dragging items within a column
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Note: You can also drag column headers on the table interfaces themselves.

Click Save to commit the changes.
Changes to columns are universal and apply to all examiner pages.

hanging (Filtering) the Content Displayed in the Examiner

In addition to sorting a log file by the display columns, you can choose to view only certain
types of logs. Follow these steps:

Click Show Options.
The View Options palette appears at the right side of the screen.

K n Exaamumney

Actions

Expxurt =

At the top of the palette, select how many logs to view, and how they will be displayed.
Place checks beside types of information you would like to see in the Examiner.
You can only filter out information.

Click Apply. The table refreshes to display the selected information.

Interpreting HView SX Pro Messages in Magellan Diagnostic Logging

Information such as Date, Time, Level, Sequence, etc., is defined by Magellan Diagnostic
Logging itself; see Magellan Diagnostic Logging’s documentation for more information on
those items.

The Message field in Magellan Diagnostic Logging is specific to the particular device. A
single device action, such as loading a layout, can trigger numerous messages in the log, as
the repercussions of that action are executed.
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The message field of a typical log entry is separated by commas, and contains the following
information:

= The source of the change, for example: Routing Notification, meaning the change
occurred as a result of an action taken at the router)

m  The location where the action took place, for example Window ID: 4 meaning a specific
Window where the action was put into effect

= The item that was triggered, such as a specific preset

m  The action that happened as a result of the triggered item, such as a source being
updated

Figure 9-13 Sample Log File from Magellan Diagnostic Logging

The log entries in Figure 9-13 describe:

= Error: This level is reserved for problems that directly affect output, such as loss of
signal and loss of reference. High-priority CCSP alarms with a level of Critical generate
this message when asserted.

= Warning: This level notifies about potential problems. Medium-priority CCSP alarms
with a level of Warning generate this message when asserted.

m  Notice: These messages apply to all alarm de-assertions and RCP connection messages.
= Informational: This level indicates routine device operation.

m  Debug: This level is disabled by default and only intended for use in specific
trouble-shooting guided by Magellan tech support.

Informational messages will be generated for all operational changes from control sources
enabled in the diagnostic logging setup. All messages control from the parametric system
are identified as CCSP.
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10 Remote Control using
Navigator and SNMP

Using Remote Control Systems with HView SX Pro

The HView SX Pro is fully compatible with CCS network control systems such as CCS
Navigator and Magellan Network Control Panel. You can also control and monitor the
multiviewer using third-party SNMP software. You can remotely perform the following
operations:

m  Select and change layouts for display

m  Select and change video input sources

m  Select audio channels for monitoring on the multiviewer's AES outputs
= Monitor the multiviewer as well as audio and video signal alarms

m  Set audio and video alarm threshold values

m  Change HView SX Pro’s IP Address and Subnet Mask

For more information about controlling the multiviewer using CCS control, see Controlling
Your Multiviewer on a CCS Network on page 129. For detailed information about using
Magellan to control and monitor your multiviewer, see your Magellan Configuration and
Operation Manual. For information on controlling the multiviewer using SNMP software, see
Monitoring the Multiviewer Through SNMP on page 135.

For information on doing firmware upgrades on your HView SX Pro modules, see Updating
Firmware with HViewUpgrade on page 138.

Controlling Your Multiviewer on a CCS Network

You can use CCS Navigator and the Magellan Network Control Panel to set CCS controllable
parameters on your HView SX Pro. CCS parameters allow you to select layouts and modify
some layout attributes. Using CCS Navigator, you can also monitor various hardware alarms,
such as operating temperature alarms.

Each output module has its own set of parameters and alarms. Before you can access these
parameters and alarms, you must discover the output module using CCS Navigator.

The following sections describe how to discover HView SX Pro and how to control and
monitor it using CCS Navigator. For information about controlling HView SX Pro modules
using Magellan network control panels, see your Magellan Configuration and Operation
Manual.



130 Chapter 10

Remote Control using Navigator and SNMP

Discovering HView SX Pro Modules Using Navigator

You can use CCS Navigator in Build mode to discover HView SX Pro modules that are
connected to a CCS network through the Ethernet connector on the back of the module.

Make sure Navigator is in Build mode.
If the Discovery Window is not open, click Tools > Discovery in the main menu.
The Discovery Window appears, most likely in the bottom left corner of the screen.

Click Options, and on the Hosts tab place a check beside Enable scanning of MAC
addresses and Configure device settings and/or device IDs.

Click OK to close the Add Host dialog box, and then OK again to close the Discovery
Options dialog box.

Click Start.

Navigator polls the network. When the poll is complete, the IP Settings and Device ID
Configuration dialog box opens.
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Figure 10-1 IP Settings and Device ID Configuration Dialog Box (HView SX Pro is in the first line)
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1

12

If your HView SX Pro has not been configured on your CCS network, it will most likely be
found at the default IP address of 192.168.100.250.

Place a check beside the HView SX Pro and click Setting Options.
The IP Settings and Device ID Options dialog box opens.
Enter an IP address, Subnet mask, and default gateway appropriate for your network.

Click OK, and then click Apply and OK to close the IP Settings and Device ID
Configuration dialog box.

Navigator runs a discovery.

When your discovery is complete, Discovery Completed is displayed in the Discovery
Window.

Click Save.
The contents of your discovery populate the Discovery folder of the Navigation Window.

You can now switch to Control mode by selecting File > Operational Mode > Control
from the main menu. Depending on which output module parameter set or alarm group
you want to view, double-click on the appropriate icon in the Navigation Window to
display the controls for a display.

Figure 10-2 illustrates a discovered output module.
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Figure 10-2 Discovering an Output Module

The following sections describe the multiviewer-related icons that appear in the Network
view after you discover HView SX Pro.

@ Click this icon to expand the discovered HView SX Pro folder.

@ Double-click to start HView Designer. For more information, see Getting Started
With HView Designer on page 34.

9 Double-click the HView SX Pro display icon to see output-related parameters and
alarms in a Control dialog box. For information about display parameter and
alarms, see Multiviewer Display Device Node Parameters and alarms on
page 132.

Parameters
and Alarms

Use CCS Navigator in Control mode or Magellan network control panel to access CCS
controllable parameters and alarms. Output modules have no card-edge controls. You must
discover HView SX Pro before you can access CCS parameters and alarms (see Discovering
HView SX Pro Modules Using Navigator on page 130).

Output module alarms function in the same way other CCS device Smart Alarms operate.
For information about how CCS Alarms work, see your CCS Navigator documentation.
Additional audio and video alarms can be viewed on display layouts and with HView
Designer software. See Using the Alarms Panel on page 79 for more information about
configuring and viewing on-screen audio and video alarms.

Parameter Table Notes

The parameters are listed in the order that they appear in CCS Navigator.
When viewing the control parameter tables, observe the following:

m  Shaded table rows indicate read-only (feedback) parameters. Some Read-only
parameters can be modified using HView Designer.
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m  Bold parameter options indicate the default settings for the parameter.

Multiviewer System Parameters and Alarms

Table 10-1 lists the system parameters, and Table 10-2 on page 132 lists system alarms.

Table 10-1 Multiviewer System Parameters

Parameter Name Function Options
Parameters
System Name Displays the name of the current Multiviewer system | (displayed system name)
Number Displays Shows the number of display devices currently (number of displays)
connected to the selected Multiviewer system

Initial Counter Time Determines the start time of any counters (00.00.00.00)
Parameters > Virtual GPI
Virtual GPI (1-24) Renders the specified virtual GPI = Disable

m Enable
Parameters > Event Control
Global Event Name Defines the global event (name of event)
Event Enable Enables selected event = Disable

m Enable
Enable All Events Enables all events = Disable

m Enable

Table 10-2 Multiviewer System Alarms

Alarm Name Description

System Major Alarm Summary Active if any alarm condition is reported
(priority > 7) for the system

System Minor Alarm Summary Active if any alarm condition is reported
(4 < priority < 7) for the system

Over Temperature Board is too hot

Fan Failure A fan on one of the modules has failed

Multiviewer Display Device Node Parameters and alarms

You can access Display device parameters and alarms for each output device that is
associated with a HView SX Pro.

To access the Display Device parameters and alarms

1 In the Network view, double-click or expand the Display folder.
2 C(lick the Parameters tab.
3 To view a consolidated list of display alarms, click the Alarms tab.
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Table 10-3 lists the CCS parameters for each display device.Table 10-4 lists the alarms for

each display device.

Table 10-3 Multiviewer Display Device Parameters

Parameter Name Function Options

Parameters/PiP/PiP Source . o o
This Parameter menu only appears when the layout currently assigned to this display contains inputs. One

instance of the parameter appears for each input. Duplicates are not represented.

Pip (x) Source Select the router source to Choose from all available router source/levels
connect to this video input.

Parameters/PiP/PiP Status
This Parameter menu only appears when the layout currently assigned to this dis(i)lay contains inputs. One
instance of the parameter appears for each input. Duplicates are not represented.

Pip (x) Status Indicates status of the video input | ® Green—No alarm
signal. A green (present) status m Red—Alarm present
for this parameter indicates that
video is available in the layout or
wall

Parameters/PiP/PiP Name
This Parameter menu only appears when the layout currently assigned to this dis(i)lay contains inputs. One
instance of the parameter appears for each input. Duplicates are not represented.

Pip (x) Name Displays the name of the video String (default: Window n)
input as assigned in HView
Designer when creating or
editing a layout

Parameters/PiP/PiP UMD Name
This Parameter menu only appears when the layout currently assigned to this dis(i)lay contains inputs. One
instance of the parameter appears for each input. Duplicates are not represented.

Primary Displays the primary name of the | String
video input as it appears on UMD
displays

Secondary Displays the primary name of the | String
video input as it appears on UMD
displays

LRC Source Displays the logical router source | String
of the video input as it appears
on UMD displays

LRC Destination Displays the logical router String
destination of the video input as
it appears on UMD displays

Parameters/PiP/PiP Full Screen

PiP ID Maximizes the selected video = FS_Off
input to full-screen = (all available video inputs, listed by their video
input Name)

Parameters/ Audio

Audio Output Selects the destination for audio |® AES
monitoring s HDMI
Pip ID Selects the audio for external = Off

monitoring = Window 1-n
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Table 10-3 Multiviewer Display Device Parameters (Continued)

Parameter Name Function Options
Stereo Pair Choose stereo pair to monitor = Embedded 1&2 Embedded 13&14
. m Embedded 3&4 Embedded 15&16
Q‘UOSSOLZZ/' s not currently = Embedded 586 TDM 182
m Embedded 7&8 TDM 3&4
m Embedded 9&10 TDM 5&6
m Embedded 11&12 TDM 7&8
Volume Adjusts the loudness of the audio | 0 - 100
being monitored
Monitor Activates or deactivates AES and/ | = Enable
or HDMI audio monitoring = Disable
Parameters/ Presets
Active Preset Select the preset to be displayed | ® Preset 1
on this output -
u
m Preset 10
Table 10-4 Multiviewer Display Device Alarms
Alarm Name Description Priority
Audio Ch1 Missing The audio is missing on the specified channel 7
|
|
Audio Ch16 Missing
Audio Ch1 Peak The audio is too loud on the specified channel 7
|
|
Audio Ch16 Peak
Audio Ch1 Low The audio is too quiet on the specified channel 7
|
|
Audio Ch16 Low
Sync Loss Sync has been lost 7
Video Freeze Content in the video frame is not changing 4
Video Black Video level remains at digital black level 7
CC Data Missing Closed Caption data missing 4
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Alarm Name Description Priority
VChip Missing VChip information is not present on line 21 field 2 | 1
ATC Missing Ancillary Time Code packets are not detected 4
within the digital video stream for a period in
excess of the duration setting
VITC Missing VITC is not detected 4

Monitoring the Multiviewer Through SNMP

Configuring a HView SX Pro as an SNMP Agent

You configure your multiviewer as an SNMP agent in HView Designer.

N o v b

On the Home tab, click Hardware Configuration to open the Hardware Config tab.

Click SNMP.
SNMP parameters become visible.

[+] Display
0 cm
D Hotwork

0 ump

B sHMP

© Time Codn
O mouter

0 atarms

Figure 10-3 SNMP Parameters

Harris Broadcast

Beside RW Community, enter the password for read/write access that the SNMP manager

will use.

Beside Subnet Mask, enter a number appropriate to your network configuration.
Type the IP address of the SNMP Manager unit in the Trap Destination IP field.

Beside Traps, select Enabled.

Click Save Changes to upload the new settings to the HView SX Pro.
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Configuring Third-Party SNMP Software Control

To set up your multiviewer with optional SNMP to communicate with SNMP MIB browsing
software, follow these steps:

1 Make the required network connections between HView SX Pro(s) and your PC with
installed SNMP browser/control software.

2 Ensure that your output module is configured to send traps to the computer that contains
your MIB browsing software.

For information on configuring SNMP on HView SX Pro, see Configuring a HView SX Pro
as an SNMIP Agent on page 135.

3 Load the Leitch mibs (downloadable from our website) into your SNMP browser/control
software:

m leitch.mib

This MIB sets up the basic structure for product specific MIBs. It can be found under the
Private > Enterprise branch in your MIB browsing software, and sets up the
leitchProducts and leitchCommon sub-branches.

The leitchCommon branch is initially empty. The leitchProducts branch contains
several initially empty sub-folders.

m  ccsAlarm.mib

This MIB adds a ccsAlarms sub-branch to the leitchCommon folder. When it is
installed, you will be able to determine what specific module or frame has triggered an
alarm (trap).

These general MIB files set up a structure to help define parameters as SNMP objects,
and alarms as SNMP traps.

4 Load the Multiviewer MIBs (downloadable from our website) into your SNMP browser/
control software:

m  ZANDAR-ARM-MIB.txt
= MULTIVIEWERSYSTEM.mib

Loads the display parameters and alarms listed in Multiviewer Display Device Node
Parameters and alarms on page 132.

The Multiviewer MIBs will appear in the (11) multiviewer folder under the LeitchProject
folder.
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Figure 10-4 Multiviewer MIBs Loaded into NUDesign MIB Browser

Configure your MIB browser to connect to HView SX Pro by entering the IP address, Port (if
you have changed the Port from its default in the configuration), and other standard
configuration settings.

Your browser should now connect to the SNMP agent running on HView SX Pro.

To receive traps, start up the trap receiver in your MIB browser software.

To verify that your configuration is correct, browse to Private > Enterprises > Leitch on
the MIB tree, and then right click on the Leitch heading and choose Walk.

You will see all the parameters and alarms for the device.
To facilitate monitoring more than one multiviewer, MIBs index devices by IP address. These

settings will be available in your SNMP manager. See your SNMP manager’s documentation
for details of how to customize its configuration.
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Updating Firmware with HViewUpgrade

As product developments occur, firmware updates may be released to introduce new
features or improve functionality. Firmware updates are applied to HView SX Pro
multiviewers using the HViewUpgrade utility. Upgrade takes approximately 20 minutes.

Before you begin, ensure that your system has the following available:

m  PIPEmicro v3.3 latest for PX and PT resource modules as of July, 2013 with current H/W
m  Network upgrade package for Hview SX Pro

m  PC connected to the target HView SX Pro

m  Navigator (v 5.1.2 is the latest as of July, 2013)

To upgrade firmware, follow these steps:

Assign an unique IP address to each set of HView SX Pro if this has not been done already.
Ping each device to ensure that all devices are responding.

Verify current PIPEmicro version and update with the latest one if required.

m  Update HView SX Pro in a Platinum router frame through Navigator

m  Update HView SX Pro in IP3 router frames through the IP3 configuration tool

Run the Network upgrade utility by launching the HViewupgrade utility.

The network upgrade utility automatically detects HView SX Pro devices in a defined frame
(IP3 and/or Platinum routers) and displays their IP, MAC, and port addresses.

If the utility does not detect some HView SX Pro devices in the defined frame, you can add
them manually:

a Add the IP address of the HView SX Pro device below Add Multiviewer.
b Click Add.

A new row is added to the Multiviewers table.

5 Put check marks in the ID column for each device as necessary.
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Figure 10-5 HView Upgrade Utility

6 Checking the boxes under Retained Items After Upgrade for items you want to keep.
You can retain previously created alarm templates, imported backgrounds, and windows.

7 Click Start and then wait while the upgrade process completes.
The upgrade process may take up to up to 20 minutes to complete.

At the end of the upgrading process, HView SX Pro devices are rebooted automatically. If
for some reason a module does not perform auto reboot, you can manually reboot the
HView SX Pro devices by re-seating individual devices or re-powering the routing system.

Il

8 Clean the history of the browser, and then exit the browser.

In Internet Explorer 8, choose Tools > Internet Options > General. Under Browsing
History, place a check beside Delete browsing history on exit and then click OK.

9 Reopen the browser and connect to the HView SX Pro again.
10 Click About to check the versions of HView SX Pro and HView designer.
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About HView Designer

HView Designer..

HView SX Pro: V2.0.22.1307152151
HVD: 2.0.0 (1.71.0.0)
FPGA: 310D:310D:1333:40B
Product Type: HVSXPRO16

|-| Harris
I—l Broadcast @ 2000-2013 Harriz Broadeast

hitp:#fharisbroadeast.com o
Close

Figure 10-6 Hview Designer About Screen

Figure 10-6 shows following information:

m  HView SX Pro version v2.0.22

m  HView Designer v1.71.0

m  FPGA versions 310D:310D:1333:40B
m  Product Type HView SX Pro 32 system
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% Specifications are subject to change without notice.

SDI Input per slot (via MI connector)

Table 11-1 SDI Input from MI connector Specification

Item

Specification

Number of inputs per slot

32 over Ml internal connector multiplexed and
re-clocked down to 16 non blocking routed sources

Connector type

Internal Ml card edge connector

Standards

= SMPTE 259M-C (SD), 525/625

m SMPTE 292M-C (HD), 720p50/59.94Hz, 1080i50/
59.94Hz

m SMPTE 424M (3G), 1080p50/59.94Hz (supported
in a Platinum frame only)

m 1080 p25

m 1080 sf25 (reports as 1080i50)
= 1080 p30

m 1080 sf30 (reports as 1080i60)
m 1080 sf23.97

Impedance

75Q +1%

Signal level

800 mV = 10% differential pairs
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SDI Flex-link Inputs

Table 11-2 SDI Input Specification

Item

Specification

Number of inputs per slot

16

Connector type

Densishield 8-way connector and internal Ml card
edge connector

Standards

m SMPTE 259M-C (SD), 525/625

= SMPTE 292M-C (HD), 720p50/59.94Hz,
1080i50/59.94Hz

m SMPTE 424M (3G), 1080p50/59.94Hz (supported
in a Platinum frame only)

= 1080 p25

m 1080 sf25 (reports as 1080i50)
m 1080 p30

m 1080 sf30 (reports as 1080i60)
m 1080 sf23.97

Impedance

75Q + 1%

Signal level

800 mV = 10% differential pairs

AES Monitoring Audio Output

Table 11-3 Discrete Audio Output Specification

Item

Specification

Number of audio inputs per slot

1

Connector type

HD-BNC connector

Standards AES3-1992 and SMPTE 276M

Impedance 75Q (0.1 to 6 MHz)

Signal level 1.0V +10%

DC offset 0OV +50mV

Rise/fall time 30ns to 44ns between at 10% and 90% amplitude
points

Jitter <0.025Ul (x0ns)

Output sample rate 48kHz

Bits 24,200r 16

Channel status and user bit

Professional mode, Normal Audio mode
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SDI

Outputs Table 11-4 SDI Output Specification

Item

Specification

Number of outputs

Up to 3 per slot

Connector type

Amphenol HD-BNC

Standards » SMPTE 292M-C (HD), 1080i50/59.94Hz
m SMPTE 424M (3G), 1080p50/59.94Hz (supported
in a Platinum frame only)
Impedance 75Q + 1%
Return loss m > 18dB from5 MHzto 1.5 GHz
m > 10 dB from 1.485 GHz t0 2.97 GHz
Signal level 800 mV = 10%
DC offset ovVx05V

Rise and fall times

m 0.75nsto 1.5 ns (SD)
< 270 ps (HD)
m < 135 ps (3G) (supported in a Platinum frame only)

Overshoot/undershoot

<10%

Jitter

< 0.2 Ul pk-pk (>10 Hz) (SD)

m < 1UI(673 ps) pk-pk of timing jitter (>10 Hz) (HD)

m <0.2 Ul (135 ps) pk-pk of alignment jitter for
(>100 kHz) (HD)

m <2 UI(673 ps) pk-pk of timing jitter (>10 Hz) (3G)
(supported in a Platinum frame only)

m <0.3 UI(101 ps) pk-pk of alignment jitter (>100
kHz) (3G) (supported in a Platinum frame only)

SFP FIBER Outputs

Table 11-5 FIBER Output Specification

Item

Specification

Number of outputs

3 per slot implemented as one single and one dual
SFP module

Connector type

LC

Standards

m SMPTE 292M-C (HD), 1080i50/59.94Hz

m SMPTE 424M (3G), 1080p50/59.94Hz (supported
in a Platinum frame only)

Output wavelength

1310 £ 20 nm
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Table 11-5 FIBER Output Specification (Continued)

Item Specification
Output power -7 dBm Typical
Rise and fall time <135ps Typical
Jitter <135 ps pk-pk
Laser safety level Class 1

HDMI OQutputs

Table 11-6 HDMI Output Specification

Item Specification

Number of outputs 3or6

Connector type HDMI Locking connector
Standards = HDMI1.3c

EIA-861B 1080p 50/59.94Hz
= EIA-861B 1080i 50/59.94Hz
m VESA CVT 1920x1200 50/59.94Hz Reduced Blanking

Impedance 50Q

Amplitude 400 mV < Vswing < 600 mV (single-ended)
Rise/fall time 75 ps < Risetime/Falltime < 0.4 Thit

Jitter 0.25 Thit

10/100/1000 Base-T Ethernet 1/0

Standard 10/100/1000 Base-T Ethernet Port as defined by IEEE 802.3-2008.

Table 11-7 Ethernet I/O Specification

Item Specification

Standard I[EEE 802.1

Type RJ45
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Linear Time Code Input

Table 11-8 Unbalanced Longitudinal Time Code

Item

Specification

Standards (compatible)

SMPTE 12M-1999

Connector type

Unbalanced, Amphenol HD-BNC

Impedance

Hi-Z (>30 kQ)

Input sensitivity

300 mV pk-to-pk

Supported Video Output Resolutions

Table 11-9 Supported Video Output Resolutions

Supported DVI output resolutions are subject to the capabilities of the connected DVI
§ display. Support cannot be quaranteed for displays with non-standard timing.

SDI HDMI

1080i 59Hz 1080p 59Hz
1080i 50Hz 1080p 50Hz
1080p 59Hz 1080p 59Hz
1080p 50Hz 1080p 50Hz

Power Consumption

Table 11-10 HView SX Pro Power Consumption Specifications

Module Name 24V (Watts) |5 V (Watts) Total Power
HV-SXP-8X3-FR28 50 0.15 50.15
HV-SXP-8X3-0-FR28 55 0.15 55.15
HV-SXP-16X3 50 0.15 50.15
HV-SXP-16X3-0 55 0.15 55.15
HV-SXP-16X6-FR28 100 0.15 100.15
HV-SXP-16X6-0-FR28 110 0.15 110.15
HV-SXP-32X6 100 0.15 100.15
HV-SXP-32X6-0 110 0.15 110.15
HV-SXP-32X6-FR28 200 0.15 200.15
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Table 11-10 HView SX Pro Power Consumption Specifications (Continued)

HV-SXP-32X6-0-FR28 220 0.15 220.15
HV-SXP-64X6 200 0.15 200.15
HV-SXP-64X6-0 220 0.15 220.15

Operating Temperature
Table 11-11 Operating Temperature Specification

Item Specification

Operating Temperature 41°to 113°F (5° to 45°C)

Propagation Delay

Table 11-12 Propagation Delay Specification

Item Specification

Video delay Less than one frame for all outputs

Audio delay Matching video delay
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Frequently Asked Questions

Overview

System FAQs

This chapter answers frequently asked questions (FAQs) and provides troubleshooting
information about your HView SX Pro system. The FAQs are organized into the following
categories:

m  System FAQs answers some common questions about your multiviewer. See System
FAQs on page 147.

m  Video input and output display FAQs answer some common questions about video
signals and display devices, as well as provide troubleshooting information about display
devices. Video Input/Output Signals and Display Devices FAQs on page 147.

m  CCS software FAQs answers common questions about using CCS software applications
with your multiviewer.CCS Software Applications FAQs on page 149.

What are FPGA Errors?

FPGA errors indicate a power-up initialization failure. Immediately after a power-on reset, a
CPLD downloads firmware into programmable logic devices (known as FPGAS).

If an initialization fails, an LED on the affected xVIM module will light up (red) to indicate

that the XVIM FPGAs are not configured. If this error occurred after a firmware upgrade, try
running the upgrade again.

What Is the Typical Video Delay of a HView SX Pro Unit?

Less than one frame, same in both DVI and HDSDI.

Video Input/Output Signals and Display Devices FAQs

Why Does the External Display Attached to the DVI Output Have
Poor Image Quality?

Most display problems can be traced to output display scaling artifacts or poor cabling.
Correcting these errors usually requires either configuration changes or higher quality DVI
cables. If the picture has lots of speckles or mosquito noise, then the DVI cable is too long.
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Frequently Asked Questions

What are “Scaling Artifacts”?

Scaling errors can occur when a display device connected to a display output is forced to
rescale an image by interpolating new pixels. This rescaling occurs because the display
resolution generated by the output does not match the native display resolution supported
by the display device. The interpolation process often introduces “scaling artifacts” that will
soften or degrade the resultant displayed image.

To avoid scaling errors, check the native resolution of the display device, and wherever
possible, configure the output to match the display’s native resolution. Also turn off any
over scan to ensure 1:1 scaling and turn off any sharpness filters. The scalar on the HView
SX Pro is most likely much superior to the scalar on the monitor so it is important to ensure
no scaling is done by the monitor to ensure the best video quality.

What is “Ghosting”?

"Ghosting” refers to vertical fringing artifacts. The use of incorrectly specified cable or
twisted pair connections most often causes this problem. Always use high-quality,
RF-screened VGA cable with individual coaxial cables for each of the red, green, and blue
signals of the VGA output.

What Calibration Adjustments are Necessary on the Attached
Display?

To ensure a high-quality picture, you should always properly calibrate the attached display
device, particularly digital display devices such as plasma displays and LCDs.

If the OQutput Signal Fails, What Should Be Done?
Check the following:

m  There is power to the output module and it is turned on (the On LED is green)

= One or more valid input signal(s) are connected and the chosen video inputs correspond
to valid input(s)

m If you are using SDI, make sure you are connected to HD monitors

m [f you are using two DVI displays, make sure they are connected to displays of the same
resolution, with the same vertical scanning rates

Why Do Some Video Tiles Appear to Have an Incorrect Format?

Ensure that the output line standard is selected to be the same as the majority of the inputs.

Check to see if you have selected the correct aspect ratio setting in HView Designer.

Why are Some Video Tiles Green?

A video tile may show as green on the HView SX Pro output display if the scalar is outside
the display group. To correct this error, open the layout in HView Designer and choose a
different video source for the tile.
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Why Do Overlapped Pips Display Artifacts?
HHView SX Pro does not support overlapped Pips.

What UMD/Tally protocols are supported by HView SX Pro?
The HView SX Pro supports the TSL protocol, Ross Tally, and Image Video protocol on TCP/IP.

Is There a Specific CCS Application Version That I Need to
Install?

Navigator 5.1.2 or later and Magellan 2.2b7 or later can be used with HView SX Pro.

Why do I have no output?

Check that the board is seated correctly, and that your cable length does not exceed the
recommended HDMI/DVI limits.

Why is my motion not smooth?

Ensure that the correct refresh rate has been set for your region (50 or 59.9Hz).

How Do I Access the Components Within a Window?

If you cannot edit or alter the components within a window, this is usually because you are
using the wrong select tool. See Window Selector and direct (internal) selector descriptions
in Tool Palette on page 25.
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Servicing Instructions

Overview
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CAUTION!

These servicing instructions are for use by qualified personnel only. To reduce the
risk of electric shock, do not perform any servicing other than that contained in the
operating instructions unless you are qualified to do so.

When servicing your HView SX Pro system, ensure that you take precautions to prevent
electrostatic discharge (ESD). See “Appendix A: Safety Precautions, Certifications, and
Compliances” in your Platinum Installation, Configuration, and Operation Manual for more
information.

These servicing instructions contain the following information:

m  Replacing a Fan on page 151

Replacing a Fan

In the event that one of the fan units fails in a HView SX Pro module, you should install a
replacement as soon as possible to prevent overheating. Replacement fans are available
from Customer Service.

To replace a failed fan unit, follow these steps:

Open the front door of the Platinum frame and remove the module or complete set of two
or four HView SX Pro output modules.

It is not necessary to remove power from the frame to remove the modules.

If necessary, separate the modules so the top of the module that has experienced the failure
can be accessed.

Identify the fan you are replacing, and then remove the corresponding header wires from
the PCB board (see Figure B-1 on page 152).

Unscrew the fan, and then pull it firmly away from the assembly to remove it from the
standoffs (see Figure B-1 on page 152).
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Appendix B
Servicing Instructions

Connector

Remove

Header Wires
screws

Pull fan off its
two standoffs

Figure B-1 Removing a Fan from the Assembly

Position a new fan over the assembly standoffs, and then fasten the fan into place with the
supplied screws.

(Ensure that the fan labeling is face down, and that the header wiring is aligned correctly, as
shown in Figure B-1.)

Do not over tighten the screws.

Connect each new fan’s header wires to the assembly PCB board (see Figure B-1 on
page 152).
Reconnect the HView SX Pro modules together in a stack.

Reinsert the HView SX Pro module set into the frame, ensuring that the alignment pin
merges with the back module and the modules fit smoothly within the module guides in
the frame.

Close the Platinum frame front panel.



153

C UMD/Tally Option

The HView SX Pro offers optional under monitor display (UMD) support. This option provides
a protocol interface (via TCP/IP) to different third-party UMD/tally generator systems in order
to display UMD source identification and tally status information. This information
automatically updates on-screen when it is changed by the tally system.

Requirements for Optional UMD Support

HView SX Pro requires a device that can generate UMD/Tally commands—for example, a
UMD generator, production switcher, or router. The HView SX Pro supports the TSL protocol,
Ross protocol, D-Series protocol, and Image Video protocol on TCP/IP to implement UMD
support.

Sample System Configurations

This section illustrates some typical multiviewer to UMD device connections. Protocols are
configured in the Hardware Config tab of HView Designer, and data is transmitted over
the Ethernet connection.

Configuring Image Video UMD Protocol

The TSI-1000 Image Video Tally Controller collects information from signal routing and

processing equipment to operate displays and tallies as directed by its internal configuration
information.

To create labels:
Syntax: %(Addr) D% 1S(strings) %Z

#D: 1~255 (UMD Address)
String: <display string up to 17 characters>
%Z: Terminator

Table C-1 Color Block Coding

First Second Third Fourth Fifth
Text color Set tally O Set tally 1 Set tally 2 Set tally 3




154 |

Appendix C
UMD/Tally Option

Configuring A8100 D-Series Automation

1

This section details the configuration settings that are required for an A8100 D-series
Automation System to drive the UMD information on aHView SX Pro multiviewer.

There are three main configuration requirements that are to be made, in order for UMDs on
HView SX Pro to be updated by A1800:

m  Configure the IP address for the HView SX Pro for UMD messages in Automation.

m  Set the Communication Port to be the same on HView SX Pro (for automation) and
A8100 (for UMD protocol messages).

m  Match the UMD/MESSAGE IDs in A8100 configuration to the UMD/MESSAGE IDs of
the UMD (PIP UMD, Automation Text Box, etc) in HView SX Pro Hview Designer.

Port Configuration in HView SX Pro

You need to set two ports in the Hardware Configuration tab of the HView designer
interface.

In HView Designer’s Home page, click Hardware Configuration.

Refresh Search

o Display

Save Changes

© cp1
© cro
Factory Reset © Network
® ump
Reboot Mutiviewer
Paort

Protocol

© snmp
© Time Code
0 Router
© Alarms
© Automation

Port

Figure C-1 Hardware Config

Click UMD to see the Port and Protocol options, and then make the following selections:
m  Port—Must be set to a different number than the Automation port below

m  Protocol—Zandar

Click Automation, and then set the Port option.
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The Automation port must be set to a different number than the UMD port. For example;
if the Port in the UMD submenu is set to 4001, then the port in the Automation submenu
can be set to 4002.

Label Source and UMD ID in HView SX Pro

You must configure the settings for each label in HView Designer.

1 In the Layout Editor, click a label.
2 The Object Properties panel updates show the object’s properties.
3 Make the following changes:
s UMD—Set to Automation.
m  Message ID (or UMD ID) for the Automation text—Set to a number greater than 64.

0 Label

Label Source " Automation
Message ID

SubID

Figure C-2 Configuring a Label for Automation

You can also set labels to Automation in the Window Editor tab of HView Designer, but
each message ID must be set individually.

Configuration in A8100

1 Open the file Zandarumd-1.xml, which is found in Equipment folder.
The Zandarumd-1.xml looks as following:

<?xml version="1.0" ?>
<Il-- DMAS configuration file -->

<zandarumd>
<num_umds>72</num_umds>
<communication>
<host>172.10.84.150</host>
<port>4002</port>
</communication>
</zandarumd>

2 To configure the IP and Port settings, change the following items:
<host>172.10.84.150</host>

Set the IP address to that of the HView SX Pro device.

<port>4002</port>
Set the port to match that of the HView SX Pro device.
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3 To configure the UMD ID, make the following change:
<num_umds>72</num_umds>
Set this line to the highest UMD ID needed.

This example uses eight Automation Text boxes, so the UMD IDs are set from 65 to 72.

4 Resave the file.

Table Mapping for UMD IDs and UMD Formatting

Three co-related types of tables need to be configured to meet UMD requirements. These
are umd_line.tbl, bus.tbl, bus_umd[1-4].tbl. These are found in the Tables folder.

umd_line.tbl

1 | zandarumd | | | 1] 65]
2 | zandarumd | | | 1] 66]
3 | zandarumd | | | 1] 67]
4 | zandarumd | | | 1] 68]
5 | zandarumd | | | 1] 69]
6 | zandarumd | | | 1] 70]
7 | zandarumd | | | 1] 71]
I

8 ]zandarumd | | 1] 72]

Configure the UMD IDs in the last column. In this example, eight UMD IDs for Automation
Text boxes are set to 65-72.

bus.tbl

In the bus.tbl table, UMD IDs are mapped to the format and fields that are to be shown on
the UMD for each respective bus. This is done in the last few columns of the bus.tbl.
Figure C-3 shows the last few columns of bus.tbl. The labeling on top indicates the
columns that need to be configured.

a B 5 3 3 3

c a & IS € €

| o > > > >

g | | | | |

a 5 5 5 5 5

o] o] o] o] o]
YININ 1 N
YININ 1 1 2 3
YIN|N i N
-1- BT 1 NI - e
YIN|N i N
-I- »T T - T
YIN|N 4 N
v NN - 3
YIN|N 1 N
vININ - N

Figure C-3 Last Columns of the bus.tbl Table

Each row in bus.tbl represents a Bus (the first row is Bus 1, the second row is Bus 2, etc.).



HView SX Pro
User Guide

Match each of the labeled columns of the tbl file to the table file name on top of the
column. The numbers in the column are index numbers of UMD IDs defined in umd_line.tbl.

Thus, UMD ID 65 (Indexed as 1 in umd_line.tbl) will have the format and fields that are
defined in bus_umd1.tbl and the data will be of Bus 2. UMD ID 66 will format and fields
define in bus_umd2.tbl and data will be of Bus 2.

bus_umd[1-4].
These table files define the format and fields to be displayed. These files look like this:

CHANNEL SOURCE [LM]20|L]A] The current source being played in the playlist of the
- DALStation Scheduler.
NEXT_EVENT_START | 1]120|R|P] The time of the next event that is to be played in playlist of
the DALStation Scheduler.
BUS [LM]20]L]A] Displays the BUS/Channel name
TIME |LM]25]|R]A] The current time
NEXT EVENT SOURCE | 1]115|L|P] The name of the next event that is to be played in playlist of
- - the DALStation Scheduler
COUNTDOWN | 1]115|R|P] The countdown to the next event to be play in the playlist of

H

the DALStation scheduler.

Any change made in the tables/files of the A8100 requires the A8100 to be re-run through
the linux terminal in order for the change to come in play.

Some table files have significantly long widths and are not viewed in correct format if a
regular text viewer such as Wordpad is used. Notepad++ can be used to avoid this.
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A

Administrator user 34
Alarm summary 132
Alarms 131-135
enable/disable 79
panel 79
paste alarm properties 63
PiP 132
settings 80-81
system 132
template 81, 104-105
template library 56
Analog clocks 63—-64
Applications 5
Aspect ratio 51
labels 77, 97
markers 70
window 66
aspect ratio
video 70
Assign inputs 29
Audio
alarm actions 81
alarms 81
audio meters 78
delay specification 146
editing audio meters 78
missing, Peak, and low alarms 134
monitoring output
specifications 142
monitoring output specifications 142
monitoring outputs 110, 133
specifications 142
mute 110
output interface select 110
over and under level 41
router inputs 23, 109
volume adjust 110
Audio meter
adding to a window 91
Audio monitoring outputs 20
Automation
configuring 154-157

159

label source 97
labels 65
AVITC 69

Back module 5, 8
Background 59
adding to the library 86
applying to layout 60

color 61
graphical 60
label with 97

window background style 93
Black picture alarm 80, 134
Black picture settings 42
Broadcast applications 5
Browser requirements 34

C

Cable connections 20
Canvas display 58
CC (closed captioning)

label 77, 97

not present alarm 80, 134

video properties 69
CCS Navigator 4, 129-131
Channels

audio 78
Clocks

editing 63—64

library 60, 83

selector 56
Color selector dialog box 61
Communication failures 132
Component view 63
Configuration

HTTP 33-81

software 23-81
Connections

audio outputs 20

DVI 20

Ethernet 19
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external 19 Edit window properties 65
HDMI 20 Editor tab 54
internal 15 Embedded audio meters 78
LTC(linear time code) 19 Enable alarms 79
output display devices 20 Ethernet connections 19
SDI 20 specifications 144
SFP 20 to GPI 21
Connectors, back module 8 Export layout 58
Container margins 90
Control 129-137 F
CCS Navigator 129-135
HTTP 33-81 Factory reset 37
SNMP 135-137 Fans
locations 6

Copy options 63
Counter start time 132
Create routing system 25
Creating

new layouts 50-53

part number for replacement 16
replacing 151-152

Features 2-4

Firmware updating 138-77

Cropping Fixed label source 77

video 71 Format menu 58

Freeze alarm 134
Full screen 38

D control panel option 109
Database editor 30 GPI trigger 39
Database, router 23 parameter 133
Default settings 132
Delete tool 57 G
Description 33
Diagnostic Logging GPI _

configuring content 126 mappings 38
Diagnostics 115 GPl input and output devices 21
Digital clocks 63-64 Graphical layout backgrounds 60
Disable alarms 79 Graticule 78, 94
Discovery using Navigator 130 Guide peg 6, 7, 8
Discrete audio meters 78 Guides 62
Display controls, layouts 57
Display Profiles H

configuring 44-47
Display profiles 43 Harredbv(\)/g;ew

g:jei?itr:gg 44;5 refresh settings from 37

Hardware configuration tab 36
HDMI connections 20

output specifications 144
HDMI output standard 38

setting as active 46
Display refresh rate 37
Display resolution 37

Displays )
configuring 44-47 " esolutons 145
def‘|n|t|on 43 . Home tab 50
D-series automation 154 HTTP control 33-81
DVI output
connecting display devices 20
resolutions 145 I
DVITC 69 Image video protocol 40, 149, 153
Import layout 58
E Index, window 65
Initial counter time 132
eBox

Input power 145
Input type 72

connections 21-22
parametric configuration 39
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Installation
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eBox 39
HView SX Pro 34, 40, 130
SNMP manager 135
IP3 frame 5
configuring HV-SXP in 23
installing HV-SXP in 17

J

JLCooper eBOX
connections 21
parametric configuration 39
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Label
adding to a window 91
Label with background 97
Labels
automation 65
editing 77, 97
modifying in window editor 97
properties 77
simple 91
source
UMD 97, 155
standalone 64
with a background 91
Layout
Background 60
Layout display controls 57
Layout recall 38
Layouts
alarm properties 59
align and distribute windows 67
creating new 50-53
definition 43
guides 62
labels 77, 97
moving objects 61
new 50
properties 59
recall 38
LEDs
Ethernet 11
LEDs, monitoring
location 6
Libraries 83-105
Panels 88
panels 89
search 84
searching 84
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widgets 88
Library pane

view, Property pane

view 57

Library tab 83
Library tools 56
Linear time code input 145
Logging on 34
Logging Server

Interface 118

LRC (logical router database) UMD indicators 77,

97
LTC (linear time code)
connection 19
specifications 145
time source 64

M

Magellan 4, 129, 129-131
Matrix, router 23
Metadata properties 69
Module status LEDs 7
Monitor, SXGA 34

Monitoring and control software 129

Monitoring audio outputs 20
Monitoring from multiple PCs 37
Monitoring LEDs

location 6
Mute audio 110

N

Navigator 4, 129-131
publishing layouts 33
Network, connecting to 19
Non-broadcast applications 5
NTP 41, 64
configuring 37

0

Operating temperature specification 146

Operator user 34

Output display resolution 37

Output modules 5-7
adding to router database 25
discovering 130
installation 17

Output rate 37

Output resolutions 145

Output standard 37

Outputs
GPI 21

Over and under levels, audio 41, 81
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Pan tool 56
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Panels SDI outputs

applied to a window 89 connections 20
Parameters 131-135 Server properties, saving 37

system device control 129-131 SFP connections 20
Paste options 63 output specifications 143
PiP parameters and alarms 132 Show routing 58
Pip sub-widget item selector 56 Show video input 58
Pip window selection tool 56 Silverlight 34
Platinum frame Simple label 91

installing HView SX Pro in 24-30 Software, Navigator 129
Platinum frame, installing HView SX Pro in 15—-18 Spacer objects 91
Poll option 25 settings 95
Port configuration Specifications 141-146

for D-series automation 154 power consumption 145
Port configuration, UMD 40 time code inputs 145
Power consumption 145 video output resolutions 145
Presets Standalone labels 64

assign layout to 58 Stereo pair

definition 43 select 134

selecting 43 Stereo pair select 110
Profiles 43 Sync
Program ID labels 97 loss of sync alarm 42, 80
Propagation delay 146 Sync time source 41
Protocol selection, UMD 40 Sync to PC 41

Sync to time source 37

R System alarms 132

System device control parameters 129-131

Read-only parameters 132 System requirements 34

Reboot 37
Redo tool 57
Redundant matrix 28 T
Refresh rate 37 Tabs
Refresh settings from hardware 37 editor 54
Reset hardware to factory defaults 37 hardware configuration 36
Resolution home 50
display 37 Library 83
monitor 34 window 87
Right click options 63 Tally
Router adding to a window 91
database 23 adding to layouts 49
installing Multiviewer in 17 editing 78
IP address 41 modifying in window editor 96
matrix 23-30 set 38
properties, editing 66 supported protocols 149
resource module 16 trigger 39
Router database 23 TDM channel alarm 81
Routing properties, editing 66 Teletext configuration 69
Rulers, viewing 57 Temperature specification 146
Template
S alarm 104
) change 52
Safe area, video 70 mode 52

Save as Active 58

SDI connections
flex link specifications 142 screen position 69
output specifications 143 Time code input 145

specifications 141 Time source 37, 41, 64
SDI output standard 38 Timer

new layout from 50
Time code
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editing 64
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Window editor 89
TSL protocol 40, 149, 153
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UMD
configuring D-series automation 154
configuring Image Video protocol 153
label source configuration 97, 155
labels 77, 97
port configuration 40
Protocol selection 40, 154
requirements 153
source 77,97

Undo tool 57

Updating firmware 138-77
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VChip

label 77, 97

not present alarm 80, 135
Video
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borders in a window 93

crop 71

delay 146

freeze alarm 134
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input type 72
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panel margins 93

PiP properties 68

safe area 70
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View rulers 61
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VITC line selection 69
Volume
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monitoring audio 134
Volume, monitoring audio 110
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Wideband matrix 26
Widgets
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deleting from a window 91
in a library 89
library 88
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sizes 92
Window
change 51
edit 63
position 66
Window tab 87
Windows
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component editing 68
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index 65
library 88
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paste alarm properties 67
properties, editing 63, 65
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renaming 99
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resize 67
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saving 98
templates 89
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video input select 66
Workspace 35-36, 107-108

Z

Z (Zandar) protocol 40
Zoom tools 56
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